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Chapter 1:  Introduction

1.1 About ERT-2501

1.1.1 ERT-2501 Feature

User Interface

ERT-2501 can use Command Line Interface (CLI) or NetGrip utility to configure.  NetGrip is used
to setup and management ERT-2501 with a user-friendly interface that works under Windows
95/98/NT/2000/ME.  You can just select the command on the pull down menu, input data on the
dialogue box as other windows program.

Protocol and Routing

© ERT-2501 support two network protocols, IP and IPX.  It supports three WAN protocol on
its WAN interface: PPP, HDLC and Frame-Relay.  It supports three frame formats on its
Ethernet Interface: Ethernet V2, 802.2, 802.3.

© Support Static routing and dynamic routing protocol, RIP.

Data Rate

© Its WAN interface data rate can be up to T1 (1.544Mbps) or E1 (2.048Mbps).

© Can utilize 100% of its T1/E1 data rate to transfer data.

Bridging

© Transparently bridges LAN that do not have routing function.

© Support Spanning Tree Algorithm

Network Management

© Connect PC to ERT-2501’ s console port, run NetGrip to manage it through the console port.

© Connect PC to ERT-2501 through Network, run NetGrip to manage it through the network.

© Connect PC to ERT-2501’ s console port, run VT-100 terminal-emulation program to manage

it through command line interface.

© Connect PC to ERT-2501 through network, run Telnet to manage it through command line

interface.

© ERT-2501 supports MIB II and can be managed by using SNMP management software.

Security

© Use IP packet filter technology to check network address, protocol type and port number.
© Use password checking function to insure the security of router’ s configuration.
© 

Table 1-1 The feature list of ERT-2501
Data Rate WAN interface can have totally 2.048bps E1 Data rate

100% utilization to transmit / receive packets on T1/E1 data rate.
LAN protocol
WAN protocol

IP, IPX
PPP, HDLC, Frame Relay and X.25

Frame Relay
Support

Complies to Q.920, Q.921 and Q.922
Supports RFC 1490 encapsulation
Supports LMI and Annex-D
Supports up to 23 PVCs
Completely supports CIR/BIR/BECH

PPP Support Completely supports RFC1661 (PPP and LCP)
RFC 1332 (IPCP)
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RFC 1552 (IPXCP)
RFC 1638 (BNCP)

Firewall support “Connect to Internet securely by using guest-list technology”
Routing Support IP RIP, IPX RIP
Compatibility Compatible with major venders’  bridge and router
Bridging Transparent bridge with all non-routable LAN protocol

Support Spanning Tree Algorithm
Network
Management

w Can be managed through the following 4 methods:
w NetGrip for Windows 95/98/NT/2000/ME
w Telnet
w VT-100 terminal program
w Standard SNMP management system

SNMP Agent Support MIB II with bridging and router extension

1.1.2 Overview

The front and rear view of ERT-2501 is showed as Fig 1-1.

Figure 1-1 The front and rear view of ERT-2501

Table 1-1 ERT-2501 component illustration
Label Description

POWER 110V/220V auto-sensing
CONSOLE DB9 (male)
Ethernet AUI (DB15 female) and RJ-45 auto-sensing
PORT 1
PORT 2

Two DB25(male) provide reliable WAN connection

The WAN port is connected to Data Terminal Equipment (DTE), you can use software to configure
this port as RS-232, RS-422, RS-485 or V.35.

The RS-232 interface is standard and can be connect to Modem with standard cable. You need
special cable for connect to other 3 non-standard interfaces.(See appendix A)

Table 1-2 ERT-2501 LED illustration

LED Description Color Status
System Power Power Green ON: Power on

OFF: Power off
System Alarm Error on Ethernet of WAN

interface
Red ON: Error

OFF: OK
LAN Status Ethernet connection Yello

w
ON: connected
OFF: disconnected

LAN Collision Collision Green ON: There is collision
OFF: No collision

WAN1 TX Transmit data Yello
w

ON: Link on
Blink: Transmitting Data
OFF: Link off

WAN2 TX Transmit data Yello
w

ON: Link on
Blink: Transmitting Data
OFF: Link off

WAN1 RX Receive data Green ON: Link on
Blink: Receiving Data
OFF: Link off

WAN2 RX Receive data Green ON: Link on
Blink: Receiving Data
OFF: Link off
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1.1.3 ERT-2501 Specification

Number 1 RJ-45 port, 1 AUI port

Data Rate 10Mbps

Protocol EthernetEthernet Port

Physical Interface
10Bsse-T : RJ-45

10Base-5 : AUI(DB15)

Number 2

Data Rate Totally 2.048Mbps (E1) data rate

Protocol PPP, HDLC, Frame Relay and X.25
WAN Port

Physical Interface DB25

Number 1

Data Rate 9600bpsConsole Port

Physical Interface DB9

Dimension (Length x Width x height) 440mm x 270mm x 44mm

Operating Temperature 0 degree C to 40 degree C

Storage Temperature -10 degree C to 50 degree C

Operating Relative Humidity 10% ~ 90% (non-condensing)

Storage Relative Humidity 10% ~ 90% (non-condensing)

AC power input
Input Voltage : 110V ~ 220V

Input Frequency : 50 Hz ~ 60 Hz

Power Consumption 40W +/- 5 %

EMI certification
FCC Part 15, Class B

EN55022, Class B

Safety Regulations

TUV EN60950

CUL CAS 950

UL 1950

Sensitivity EN50082-1 (IEC801)

1.2 ERT-2501 Typical Application
The typical network application of ERT-2501 is:
© Point to Point Bridging.
© Point to Multi-Point Connection.
© Virtual Private Network (VPN).
© Internet connection

1.2.1 Bridging

The simplest application of ERT-2501 is Point to Point Bridging(see Fig 1-3).  It simply connect to
remote LAN.  It is ERT-2501’ s default settings.  You just need to “Plug and Play”.
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Fig 1-3   ERT-2501 Point to Point Bridging

1.2.2 Point to Multi-Point Connection

For users that want to connect all their remote sites to a central site, ERT-2501 will be a good
solution for the remote sites.  Users can connect the remote LANs with multi-protocol to a central
multi-port routers located on the central site (see Fig. 1-4).

Fig 1-4   ERT-2501 Point to Multi-Pint Application

On above example, each ERT-2501 is configured with PPP Protocol on its WAN Port and uses
dial-up network to connect with central router.  Some remote offices probably are RD centers that
formed by UNIX workstation running TCP/IP.  Some other remote offices probably are sales
points that formed by Novell workstation running IPX/SPX.  The other remote offices may support
both IP and IPX as central Office.

Most service request come from remote offices to central offices.  However, you probably need
visit a remote office’ s server from another remote office or need messages transfer (including e-
mail) between remote offices.  All those data flow can go through central office’ s router.

You can disable the unused network protocol when configuration ERT-2501.  Since use routing
protocol, Bridging function should be also disabled.  The central router probably is provided by
other vender, thus its compression algorithm probably is incompatible from ERT-2501 and should
also disable data compression.
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1.2.3 Virtual Private Network

In a virtual private network (Fig 1-5), LAN to LAN is connected through the permanent virtual circuit
of public frame relay network.  Using virtual circuit can get better redundancy.  In fact, complete
network connection can realize by distribute independent virtual circuit for each ERT-2501 pairs.

Fig 1-5   ERT-2501 Virtual Private Network

1.2.4 Internet connection

You can install ERT-2501 on client side for Internet connection.  The connection between LAN
and Internet is provided by the PPP link of Internet Service Provider.

1.3 Product Configuration

1.3.1 First configuration of ERT-2501

You can connect a PC, terminal or UNIX workstation to ERT-2501 console interface to make first
configuration.  You can also connect a Modem to ERT-2501’ s console port and dial in to make
first configuration.  The further configuration can be make through IP network.  The following
hardware requirement is suitable for console port connection.

Requirement for Console Port connection:

VT-100 terminal, or UNIX workstation or PC that run VT-100 terminal emulation program.  The
terminal should have the following settings:
Emulation type: VT-100
Baud rate: 9600
Data bit: 8
Parity Check : None
Stop bit: 1
Flow Control: None

Requirement for NetGrip:

Use one Windows 95/98, Windows NT 3.51 or later Windows OS PC with DB9 (COM) serial port to
connect the console port of ERT-2501.  If there is only a DB25 (COM) serial port interface, you an
use a DB9/DB25 interface converter to connect the control cable and PC’ s serial port.
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Control cable for ERT-2501:

You need a Control Cable for connecting PC, terminal or a UNIX workstation to ERT-2501’ s
console port (refer to Fig 1-7 and appendix A).

Fig 1-7 Use Control Cable to connect ERT-2501’ s console port

Requirement for connecting Modem to ERT-2501’ s console port:

A modem cable with DB9 connector to connect.  The Modem use the same parameter of console
port connection (refer to Fig 1-8 and Appendix A).

Fig 1-8 Connect Modem to console port of ERT-2501

The following is the configuration procedure:
© Connect ERT-2501’ s console port to a PC

1. Shut down the power of ERT-2501 before connecting.
2. Connect Control Cable’ s DB9 connector to ERT-2501’ s console port.  Connect another

DB-9 connector to PC’ s serial port.   Power on PC.
3. Power on ERT-2501.
4. Check if ERT-2501’ s power LED is green.
5. Ready to enter its command line interface of install NetGrip program.

© Connect ERT-2501’ s console port to a workstation or terminal device.
1. Start the UNIX workstation or VT-100 terminal.
2. Connect the DB-9 connector of Control Cable to ERT-2501’ s console port, connect another

DB-9 connector of Control Cable to a UNIX workstation or terminal device’ s serial port.
3. Power on ERT-2501
4. Check if ERT-2501’ s power LED is green.
5. Ready to enter its command line interface to configure this router.

1.3.2 Install NetGrip management utility

NetGrip can be used on Windows 95, Windows 98, Windows 2000 and Windows NT or later
Windows version.  ERT-2501 is provided with an installation CD.  The installation procedure is
as the following:

1. Insert the installation CD to your CD-ROM Drive.  Click “Start”  -> “Run” -> “e:\utility\setup.exe”.
(Assume letter E is the CD-ROM drive)

2. The Installation Wizard will startup the installation and guide you the whole process. After the
installation, install wizard will create a small icon on the Desktop for easy locate and execute the
program.
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1.3.3 Connect to network

After configure ERT-2501’ s console port parameters and save, you can connect to network by the
following options:
© WAN connection: use PLANET V.35 WAN cable, or DB25 too DB25 (RS-232) WAN cable.

© LAN Ethernet connection: use 10Bast-T ( connect the RJ-45 port) or 10Base-5 cable (connect
the DB-15 port)

© Modem connection: Use modem cable to connect ERT-2501’ s WAN port.
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Chapter 2  NetGrip user’s Guide

2.1  Enter NetGrip

Start NetGrip in Windows , you can see a screen like Figure 2-1.

Figure 2-1  Connection Type Dialogue Box

Connection Type options:

© Consol Use PC’ s serial port to connect ERT-2501’ s console port through Console Cable.

© Network Use IP network to connect ERT-2501 Ethernet port

© Modem Use modem to connect ERT-2501’ s console port.

© Exit Quit NetGrip

2.1.1 Connection Type > Console

When you select Console, please connect ERT-2501’ s console port to PC serial port. In general,

we use this type of connection to connect ERT-2501and configure it’ s IP, IPX address or other

network parameter, then we can enter ERT-2501 configuration screen through IP Network.

Click on Console, NetGrip will display “Local Connect Settings”  dialogue box as shown on

Figure 2-2.
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Figure 2-2 Connection Type > Console

You can select the default “COM1” or use the pull down list to select another console port.

¡ ]1¡ Ĉlick Save as Default to set the Com Port you selected become to default console port .

¡ ]2¡ Ĉlick Connect to establish connection to ERT-2501.

After click Connect, Check Password dialogue box will appear, like Figure2-3.

Figure 2-3 Check Password dialogue box

Please enter correct password and then click OK, now you can see the Validating password

dialogue box, as Figure 2-4. After password checking, now you are connecting to ERT-2501. If

you click “Cancel” button, you will back to Local Connect Settings dialogue box.

NOTE: The default password is “admin” all lower case.

Figure 2-4 Validating password dialogue box

Parameters of PC console port is as the following:

Bits per second ¡ G9600

Parity ¡ GNone

Data bit ¡ G8

Stop bit ¡ G1

Flow control ¡ GNone

To use NetGrip, there is no need to configure the parameters.
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2.1.2 Connection Type > Network

     

Click Network, NetGrip will display Network connection dialogue box, as Figure 2-5.

       Figure 2-5 Connection Type > Network

Please enter ERT-2501’ s IP address in Remote IP Address.

¡ ]1¡ Ĉlick Add to save Remote IP Address to Address book .

¡ ]2¡ Ĉlick Connect to establish communication with ERT-2501.

After click on Connect, Check Password dialogue box will appear. The operations is the same

with Console-connection, please refer to section 2.1.1.

 Before use this configuration, you must use console port to set an IP address for ERT-

2501, then you can configure ERT-2501 through the Network.

2.1.3 Connection Type > Modem

Click Modem, NetGrip will make a dial connection toERT-2501’ s console port through modems as

shown on Figure 2-6.

Figure 2-6 Connection Type > Modem

Select the Com Port you need from the pull down list:

(1) Click Save to save the dial string on Dial String field.

(2) Click Dial to make your modem start to dial.

After click Dial, Check Password dialogue box will appear. The operations is the same as Console

connection, please refer to section 2.1.1.

“1234567” here, in dial string is the telephone number.  Please refer to modem model and the
other party’ s telephone number to setup the dial string.



- 13 -

Please set the modem’ s parameter as the following to connect ERT-2501’ s console port:

Bits per second ¡ G9600

Parity ¡ GNone

Data bit ¡ G8

Stop bit ¡ G1

Flow control ¡ GNone

2.2  NetGrip Menu

After connect successfully, you can enter NetGrip’ s setup screen as shown on Figure 2-7.

Figure 2-7 NetGrip setup screen

2.2.1 File menu

You can open or save NetGrip configuration file to your hard disk or a floppy disk as shown on
Figure 2-8
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Figure 2-8 File Menu

File > Open  Open a saved NetGrip configuration file. Select Open, NetGrip will display Open

dialogue box, you can select the file you want to open in this dialogue box like Figure 2-9.

Figure 2-9  Open dialogue box

File > Save Save your configuration to a file.

File > Save As  You can save the configuration to a specified file name. When you select Save

As, you can see the Save As dialogue box as shown on Figure 2-10. Enter the file name and then

click OK. You don’ t need to enter file extension name, NetGrip will automatically use the extension

name as the product ID (for example, 007).

Figure 2-10  Save As dialogue box

File > Exit  Exit NetGrip. If you don’ t save the configuration, NetGrip will prompt if you want to

save the configuration to a file or not.
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2.2.2 Connect menu

You can select one of the methods for NetGrip to connect to ERT-2501 as shown on Figure 2-11.

Figure 2-11  Connect Menu

You can select the following command:

© Console:   Use a RS-232 cable to connect PC’ s serial port and ERT-2501’ s console port.
© Network:   Connect to ERT-2501’ s Ethernet port through IP network.

© Modem:    Connect to ERT-2501’ s console port through modem cable.

Please refer to Chapter 2.1 for detail.

2.2.3 Update menu

You can select the command in Update pull down list as shown on Figure 2-12.

Figure 2-12  Update Menu

Update > Store to Flash  Use this command to transmit the new configuration to ERT-2501.

After modify configuration or reload saved configuration file, please use this command to update

ERT-2501.

Update > Upgrade Firmware   Use this command to upgrade ERT-2501’ s firmware. You can

download the latest firmware from Planet Web Site (http://www.planet.com.tw).

Update > Read Configuration   Use this command to read ERT-2501’ s current configuration.

Update > Reboot Router   Use this command to reboot ERT-2501.
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2.2.4 Advance menu

In Advanced pull down list, you can use some advanced function here, like Figure 2-13.

Figure 2-13  Advance Menu

Advance > Ping  show Ping dialogue box, like Figure 2-14

You can use this function to test the connectivity between this router and remote network device by
repeatedly transmit and receive ICMP Echo Request packets. If you can receive the ICMP Echo
Reply packet correctly, it means your router can connect to the remote network device. If you do
not receive the packet, it mean the remote network device is not working the network is blocking.

F2-14  Advanced > Ping

The following fields can be changed

© Target Address

© Buffer Size¡ ]Max 1472 byte¡ ^

© Interval¡ ]in seconds¡ ^

(1) Click Save to save your changes.

(2) Click Start to transmit packets. You can see total number of transmit and receive packet at the

same time.

(3) After Ping start, you can use the Stop button to stop.

Advance > Setup Password  Show Setup Password dialogue box, like Figure 2-15.
(1) Please enter the same words in “New Password” field and “Confirm Password” field.

(2) Click OK to save the password.
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Figure 2-15  Advanced > Setup Password dialogue box

Password setting in NetGrip will also apply to command line interface.

If you want to delete password, please click Clear. After password delete, password will restore to
default password “admin”.

Advanced > IP Firewall   Show IP firewall dialogue box, like Figure 2-16.

Figure 2-16  Advanced > IP Firewall dialogue box

Note¡ GYou can have maximum 8 Firewall settings in the list.

After add IP Firewall parameter, you can see the following items on the IP Firewall list.

¡ º Source Address, Source Mask

¡ º Dest Address, Dest mask

¡ º Protocol/Port, Action (Drop or Forward)

(1) Add IP Firewall

1. Click Add, IP Firewall dialogue box will pop-up, like Figure 2-17. Please enter the
parameters in each field.

Figure 2-17 IP Firewall dialogue box

1.2 Please select an IP Protocol in IP protocol pull down list, like Figure 2-18. The available
protocols are : Telnet, FTP, TFTP, NNTP, SMTP, HTTP, TCP, UDP, ICMP, Any, Others.
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F2-18  Select IP Protocol dialogue box

1.3 You can select a method to process data packet on Action field, Drop or Forward.

1.4 Click OK, then you can see all the IP Firewall parameters are listed on the IP Firewall
Setup window.

2. Modify IP Firewall parameter

2.1 In IP Firewall, please select the item you want to modify, then click Edit, IP Firewall
dialogue box will pop up.(Refer to Figure 2-17).

2.2 Change IP Firewall parameter, click OK, you can see the parameter had been changed in
IP Firewall Setup window.

2.3 Adjust IP Firewall sequence in IP Firewall list .

Sequence on the list decides the function of Firewall. If you need to change their
sequence, please select the IP Firewall you want to adjust and then click UP or DOWN.

(3) Delete IP Firewall

3.1 Select the IP Firewall item you want to delete.

3.2 Click Delete. When NetGrip confirm window appear, click Yes to delete or No to return to IP
Firewall window.

Advanced > Display Router Info.  You can see the System name, System Version, Release
date, Serial NO and Device ID in this Router Information box, like Figure 2-19.

Figure 2-19  Advanced > Router Information
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2.2.5 Help menu

You can see the Help menu in NetGrip, like Figure 2-20.

Figure 2-20  Help

After click Help, you can see the NetGrip Version and copyright information, like Figure 2-21.

Figure 2-21 Version Information

2.3 Router’s parameters configuration
Router’ s parameters configuration is implemented by a series tab windows, as figure 2-22. You can click
the tab button to switch different configuration windows (tab windows) and make the configuration of the
router.

Figure 2-22 Tab Windows

2.3.1 Setup tab window

The Setup table window include the following sub tab windows.

© Physical Port window

© Logical Port window
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© Bridge window

2.3.1.1 Introduction to Physical Port configuration

Click Setup button, it shows three options: Physical Port, Logical Port and Bridge.  The
physical Port configuration window is as shown on Figure 2-23.

Figure 2-23 Physical Port

In this window, the available options is as the following:
© Physical Port

LAN
Port1
Port2

© IPX encapsulation( for LAN port)
802.3
802.2
V2

The following options are available for WAN port:
© Connection Type

V.35
RS-232
RS-422
RS-485

© Speed (unit: bps)
9600, 14400, 19200, 28800, 38400, 57600, 64000, 115200, 256000, 512000,
T1(1544000) or E1 (20480000).

Please refer to the following for maximum connection speed of each connection type:

 Connection Type Maximum Speed
V.35 T1 or E1
RS-232 64kbps
RS-422 T1 or E1
RS-485 T1 or E1
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if transmit and receive compressed data, the speed of ERT-2501 should not
be higher than 64kbps.

© WAN protocol
HDLC (only work between ERT-2501s)
PPP
Frame-Relay (can not be used on dial-up connection)
X.25

² Configuration of Frame-Relay
Select FRAME-RELAY on WAN protocol will activate FRAME-RELAY button,
click this button will show frame relay dialogue box as figure 2-24.  Please select
LMI, Annex-D or Off on Management Interface field; select Q921, Q922 on
Address Format.  Then input corresponding value on other fields.  Click OK to
complete.

Figure 2-24 WAN protocol – Frame Relay
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² Configuration of X.25
Select X.25 on WAN protocol will activate X.25 button, click this button will show
X.25 dialogue box as figure 2-25.  Input corresponding value on each field then
click OK to complete.

Figure 2-25 WAN Protocol - X.25

2.3.1.2 Introduction to Logical Port Configuration

Click Logical Port tab window, select a item on list frame, double-click it or click Edit
button, it will pop-up Logical Port setup dialogue box as show on 2-26.
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Figure 2-26 Logical Port setup dialogue box

1. Configure wan1 logical port (select from the pull-down list)

© Logical Port: Can keep or change the logical port’ s name.

© Physical Port: Select the suitable physical port.

© Compression: Select Yes or No.

© Priority: Input integer from 0 to 255, 0= highest priority, 1=next high priority …

© Line Usage: Select one of the following mode on Line Usage:

² Normal:Normal line means the port is always on.  The line will be on when ERT-2501 is turn on or
when the user initialize the logical port to be “Normal”.  When the link fail or the user
prohibits the port, it will be terminated.  When the initialization condition is met, ERT-2501
will run the command on Dial String.  The Dial String dialogue box can be shown by
click Dial String button, as shown on Figure 2-27.

Figure 2-27 Dial String dialogue box (Normal)
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² Dial-on-demand: Dial on demand line is activated when data transmission is needed.  If there is
any data waiting for transmission, it is initialized.  If there is no any data transmission for
more than the Inactivity Timeout (default is 300 seconds), it will be terminated.  If you
have input Dial String, ERT-2501 will run the command when it starts to dial.  The Dial
String dialogue box will be shown when click Dial String button.  You can also input
Inactivity Timeout on this dialogue box as shown on Figure 2-28.

Figure 2-28  Dial string dialogue box (dial-on-demand)

² Backup:Backup line is a substitution path when the major link is faulty.  When major line is faulty,
the backup line is initialized.  When the major line’ s problem is solved, the backup line is
terminated.  If you have input Dial String, ERT-2501 will run the command when it starts
to dial.  The Dial String dialogue box will be shown by click Dial String button.  You can
also input the major line’ s logical port as shown on Figure 2-29.

Figure 2-29 Dial String Dialogue Box (Backup)

² Load Balance: Select Yes on Load Balance field to add this logical port to Load Balance group.
Select No to not add.
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2. Configure Frame Relay of Logical Port
Click Setup > Logical Port tab window, select an item on list frame, double-click it or click Edit button, it
will pop-up Logical Port setup dialogue box as show on 2-30.

Figure 2-30 Configure Frame Relay for Logical Port

1) Double Click Frame Relay button on Logical Port window, it will show Frame Relay – WAN1 dialogue
box.

2) Input suitable Frame Relay parameters including Connection ID, Committed Information Rate (CIR),
Committed Burst Information Rate (CBIR) and Rate Measurement Interval.   
Note: Only Frame Relay allow multiple logical port, ERT-2501 allow maximum 23 logical port and each
frame relay logical port must have a unique Connection ID.

3. Configure Network Protocol of Logical Port

1) Click Network Protocol button on Logical Port window, it show Network Protocol dialogue box.  It
has three tab windows: IP, Novell IPX and Bridge.

2) Configuring IP, IPX and Bridge parameters based on a logical port.
Click IP tab on Network Protocol window as shown on Figure 2-31.
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Figure 2-31 Configure IP protocol

© IP: Select Enabled or Disabled on pull down list.
© Input settings on IP address and Subnet Mask field.
© Select needed option on Routing Protocol pull down list.  If select RIP, you can click RIP button to pop

up the RIP configuration dialogue box as shown on Figure 2-31.  Select needed option on Send RIP
broadcast and Receive RIP broadcast pull down list and input the values for Renew Interval and
RIP metric.

© Input proper value for Metric and MTU (Maximum Transmit Unit).

Click Novell IPX tab on Network Protocol window as shown on Figure 2-32.
© Select Enabled or Disabled from the pull down list of Novell IPX field.
© Input value on Network Number
© Input needed value on Routing Protocol, Transmit RIP broadcast, Receive RIP broadcast, Send

SAP broadcast and Monitor SAP broadcast pull down list.
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Figure 2-32 Configure IPX protocol

Click Network Protocol tab on Network Protocol window as shown on Figure 2-33.
Select Enable or Disable on Bridge field.

Figure 2-33 Configure Bridge

Insert or delete logical port

Insert logical port: Select Logical Port tab window, click Insert button, it show Logical Port dialogue

box, configure needed information to add the logical port.

Note: Only WAN physical port with Frame Relay can add Logical Port.

Delete logical port: Select Logical Port tab window, select the logical port to be deleted from the list,

click delete, a confirmation box will appear, click Yes to confirm, click No to cancel.
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4. Configure X.25 of Logical Port
Double-click Logical Port WAN1 or WAN2  (assuming WAN1’ s corresponding WAN physical port has

been configured with X.25 protocol in this example), it will show Logical Port dialogue box.  Click X.25

button to enter X.25 Logical Port Setup window and configure it.  Shown as Figure 2-34.

Figure 2-34 Configure X.25 of Logical Port

2.3.1.3 Introduction to Bridge Configuration

In general, user uses bridge for non-IP and non-IPX protocol, and use IP and IPX static route at the
same time.

Please Select Bridge on Setup tab, it will show Bridge window as figure 2-35.
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Figure 2-35 Bridge Window

The available parameters is:
© Name: the name of the bridge
© Priority: 0 = the highest priority, 1= the second high priority, 3=the third high priority, etc..
© Enable Spanning Tree: The default is No.

2.3.2 Static Route tab window

Static Router tab include the following sub window:

© IP Route
© IPX Route
© IPX Service
© X.25 Mapping
© 
In general, user use IP and IPX static route and bridge all non-IP and non-IPX protocol.

2.3.2.1 Introduction to IP Route configuration

Please click Static Route > IP Route as shown on Figure 2-36.
Information listed on IP Route window are: Destination IP, Destination Mask, Gateway
and Metric.
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Figure 2-36 IP Routing Table

© Insert a static IP route
Click Insert, Static IP route dialogue box will shows as Figure 2-37.

Figure 2-37 Configuration IP route dialogue box

Input proper values on each field and click OK to return IP Route window.

Static IP Route table can have maximum 8 entries.  If IP RIP is disabled, static route is
selected automatically. Besides, static route must have at least 1 entry.  After configuring IP

Route, must “Store to Flash” and reboot to make it active.  The default entry can be Destination
IP: 0.0.0.0 and Mask: 0.0.0.0 so that all uncertain route’ s IP packet is sent to the default gateway.
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© Edit a static IP route
Double-click an entry (or click Edit button) on the IP Route table to enter Static IP Route dialogue box
as shown on figure 2-37.  You can change any information on the box.  Click OK to return IP Route
window.

© Delete a static IP route
Select an entry on the IP Route table and click Delete.  Click Yes to confirm or No to cancel.

2.3.2.2 Introduction to IPX Route Configuration

Please click Static Route > IPX Route as shown on Figure 2-38.  You can have
maximum 8 entries on the IPX Route table.

Figure 2-38 IPX Route Table

Information listed on IPX Route window are: Destination, IPX Gateway, Hop and Ticks.

© Insert a static IPX route
Click Insert, Static IPX route dialogue box will shows as Figure 2-39.
Input proper values on each field and click OK to return IPX Route window.

Static IPX Route table can have maximum 8 entries.  If IPX RIP is disabled, static
route is selected automatically. Besides, static route must have at least 1 entry.

After configuring IPX Route, must Store to Flash and reboot to make it active.
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Figure 2-39 IPX Route configuration dialogue box

The meanings of each field on above figure is:
49= Destination IPX address’ s network ID
1= IPX address’ s network ID of next router
000209112233 = IPX address’ s node ID of next router.

© Edit a static IPX route
Double-click an entry (or click Edit button) on the IPX Route table to enter Static IPX
Route dialogue box as shown on figure 2-39.  You can change any information on
the box.  Click OK to return IPX Route window.

© Delete a static IPX route
Select an entry on the IP Route table and click Delete.  Click Yes to confirm or No to
cancel.

2.3.2.3 Introduction to IPX Service configuration

Please click Static Route > IPX Service as shown on Figure 2-40.

Figure 2-40 IPX Service window
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© Insert a static IPX Server
Click Insert, Static IPX Service dialogue box will shows as Figure 2-41.
Input proper values on each field and click OK to return IPX Service window.
Note: After selecting Server Type, the Server Type value in hexadecimal format will automatically
show.

Figure 2-41 Static IPX service

© Edit a static IPX Service
Double-click an entry (or click Edit button) on the IPX Service table to enter Static IPX Service dialogue
box as shown on figure 2-41.  You can change any information on the box.  Click OK to return IPX
Service window.

© Delete a static IPX Service
Select an entry on the IPX Service table and click Delete.  Click Yes to confirm or No to cancel.

2.3.2.4 Introduction to X.25 Mapping

Please click Static Route > X.25 Mapping as shown on Figure 2-42.
Information listed on X.25 Mapping window are: Destination IP Address. Destination
X.25 Address, PVC Flag, Logical Channel and CUG number.
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Figure 2-42 X.25 address mapping window

© Insert a X.25 address mapping
Click Insert, X.25 Address Mapping dialogue box will shows as Figure 2-43.  Input proper values on
each field and click OK to return X.25 Mapping window.

Figure 2-43 X.25 Address Mapping dialogue box

Both the Destination IP Address and Destination X.25 Address are unique.

© Edit a X.25 address mapping
Double-click an entry (or click Edit button) on the X.25 Mapping table to enter X.25 Address Mapping
dialogue box as shown on figure 2-43.  You can change any information on the box.  Click OK to
return X.25 Mapping window.

© Delete a X.25 address mapping
Select an entry on the X.25 Address Mapping table and click Delete.  Click Yes to confirm or No to
cancel.

2.3.3 Statistic tab window

Statistic tab window include the following sub window:
© Interface
© IP
© UDP
© IPX
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2.3.3.1 Interface statistic

The Interface tab lists the information of each physical port as shown on figure 2-44.

Figure 2-44 Interface statistic information

1) Logical Port: select from the pull down list.
2) Click Renew, the information is listed on the following field.:

© State Disabled (used on dial-up connection), Down, Up, Error (please call
your dealer for help if it happens).

© IP State Disabled, Enabled (the interface may have some problem), Active.
© IPX State Disabled, Enabled (the interface may have some problem), Active.
© STP StateDisabled, Blocking, Listening, Learning or Forwarding.  The last four

states are allowed if STP is enabled.  When the network status is
changed (for example, add a new bridge), those states are normal.

© Forward Transitions: Number of transitions from Blocking to Forwarding due to
STP reconfiguration.

© MtuExceededDiscard: Total number of frames the interface discard due to
exceed the MTU (maximum transfer Unit).

© LastChange: Time between system is boot and the last change of interface status
(unit at 1/8 seconds).

© InOctets Number of bytes the interface receives.
© InDiscards: Number of frames the interface discards due to buffer overflow or

other system resource problem.
© InErrors Number of error frames the interface receives.
© OutOctets: Number of bytes the interface transmits.
© OutErrors: Number of frames affected by transmission error.

2.3.3.2 IP statistic

The IP tab lists the statistic information of IP as shown on figure 2-45.

Figure 2-45 IP statistic information
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Click Renew, the information is listed on the following field:

© Default TTL The default value inserted into the Time-To-Live field of the IP header of
datagrams originated at ERT-2501, whenever a TTL value is not supplied by the
transport layer protocol.

© InReceives Total number of input datagrams received including those received in error.

© InHeaderErrors Number of input datagrams discarded due to errors in their IP headers.

© InAddressErrors Number of input datagrams discarded because the IP address in their IP
header’ s destination field was not a valid address to be received at this device.

© InUnknownProtocols Number of locally-addressed datagrams received successfully but discarded
because of an unknown or unsupported protocol.

© InDeliver Total number of input datagrams successfully delivered to IP user-protocols
(including ICMP).

© InDiscards Number of input IP datagrams for which no problems were encountered to
prevent their continued processing, but which were discarded (for example, for
lack of buffer space).

© ForwardDatagrams Number of input datagrams for which this device was not their final IP
destination, as a result of which an attempt was made to find a route to forward
them to that final destination.

© OutRequests Total number of IP datagrams that local IP user-protocols (including ICMP)
supplied to IP in requests for transmission.

© OutDiscards Number of output IP datagrams for which no problem was encountered to
prevent their transmission to their destination, but which were discarded (for
example, for lack of buffer space).

© OutNoRoutes Number of IP datagrams discarded because no route could be found to transmit
them to their destination.

© ReassembleNeeds Number of IP fragments received that needed to be reassembled at this device.

© ReassembleTimeout Maximum number of seconds that received fragments are held while they are
awaiting reassemble at this device.

© ReassembleOKs Number of IP datagrams successfully reassembled.

© ReassembleFails Number of failures detected by the IP reassemble algorithm (for whatever
reason: timed out, errors, and so on)

© FragmentOKs Number of IP datagrams that have been successfully fragmented.

© FragmentFails Number of IP datagrams that have been discarded because they needed to be
fragmented but could not be, for example, because their Don’ t Fragment flag was
set.

© FragmentCreates Number of IP datagram fragments that have been generated as a result of
fragmentation.
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2.3.3.3 UDP statistics

The UDP tab lists the statistic information of UDP as shown on figure 2-46.

Figure 2-46 UDP statistic information

Click Renew, the information is listed on the following field:

© InDatagrams Total number of UDP datagrams delivered to UDP users.

© NoPorts Total number of received UDP datagrams for which there was no application at
the destination port.

© InErrors Number of received UDP datagrams that could not be delivered for reasons other
than the lack of an application at the destination port.

© OutDatagrams Total number of UDP datagrams sent from this router.
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2.3.3.4 IPX statistic

The IPX tab lists the statistic information of IPX as shown on figure 2-47.

Figure 2-47 IPX statistic information

Click Renew, the information is listed on the following field:

© InHeaderErrors Number of input packets discarded due to errors in their IPX headers.

© InAddressErrors Number of input packets discarded because the destination address was
not a valid address to be received at this router.

© ForwardDatagrams Number of input packets for which this router was not their final IP
destination, as a result of which an attempt was made to find a route to
forward them to that final destination.

© InUnknownProtocols Number of locally-addressed packets received successfully but discarded
because of an unknown or unsupported protocol.

© InDiscards Number of input IPX packets for which no problem were encountered to
prevent their continued processing, but which were discarded (for example,
for lack of buffer space).

© InReceives Total number of input packets including those received in error.

© OutRequests Total number of IPX packets that supplied to router in requests for
transmission.

© OutDiscards Number of out IPX packets for which no problem were encountered to
prevent their transmission to their destination, but which were discarded
(for example, for lack of buffer space)

© OutNoRoutes Number of IPX packets discarded because no route could be found to
transmit them to their destination.
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Chapter 3 Command Line Interface

3.1 System Commands

3.1.1  Command List

System commands include:

add password

delete password

logout

modify console

modify debug mode

modify password

reboot

save

show console

show debug mode

show version

  

3.1.2 add password

setup log on password

add  password  newone

Syntax Description:

newone  New password. Password may be composed of alphabet, number, and symbols.

Usage Guidelines:

ERT-2501’ s default password is “admin”. To activate new password, please save settings

and restart your ERT-2501.

Sample Display:

Set password as “planet“

cli> add password planet

cli> save

done config

cli> reboot

Related Commands:

delete  password, modify  password, save, reboot
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 3.1.3 delete  password

delete password

delete  password

Usage Guidelines:

After deleting password, save settings and reboot ERT-2501, The password will return to default

password “admin”.

Sample Display:

cli> delete password

Related Commands:

add password, modify password, save, reboot

3.1.4  logout

Quit Command Line Interface (CLI)

logout

Sample Display:

cli> logout

goodbye

Related Commands:

reboot

3.1.5 modify console

Configure NetGrip to access ERT-2501 via console port or not

modify  console  console

Syntax Description:

console can be yes or no, and also can be y or n in short.  Use this command to allow or prohibit

NetGrip to access ERT-2501 via console port.

Default:

NetGrip is set to be able to access ERT-2501 via console port.
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Usage Guidelines:

© This restriction only applies to NetGrip running on local computer for connecting to ERT-2501
through console port. It has no influence on the remote computer with NetGrip installed to
access ERT-2501 via IP network. Users can setup firewall to control the accessibility to
ERT-2501 for remote computer with NetGrip installed.

© Command: “modify console yes“ will disable the accessibility from NetGrip to ERT-2501 by
console port. Command: “modify console no“ will enable the accessibility from NetGrip to
ERT-2501 by console port.

© To activate modification, please save settings and restart ERT-2501.

Sample Display:

cli> modify console no

Related Commands:

show console, save, reboot

3.1.6 modify debug mode

Debug mode

modify  debug  mode  dummy

Usage Guidelines:

This command is only used for internal development and test.

Sample Display:

cli> modify debug mode 0

Related Commands:

show debug mode

3.1.7 modify password

Modify user’ s password

modify  password  newone

Syntax Description :

newone is the new password. Password could be composed of alphabet, number, and symbols.
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Usage Guidelines:

Same as command “ add password “.

Sample Display:

cli> modify password planet

Related Commands:

add password, delete password, save, reboot

3.1.8 reboot

Reboot ERT-2501

reboot

Usage Guidelines:
After configure ERT-2501, it is required to save the configuration and reboot to activate the
settings.

For example:

cli> reboot

Related Commands:

save

3.1.9 save

Save new setting or modified setting to flash.

save

Usage Guidelines:

After configuring ERT-2501, it is required to save settings and reboot ERT-2501 to activate the

settings.

Sample Display:

cli> save

done config

Related Commands:

reboot
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3.1.10 show console

Display console port information:  

show  console

Usage Guidelines:

This command can be used to display console port for development and testing purpose.

Sample Display:

cli> show console

Netgrip Enabled Yes Console Port 3

Console State 3 Console Substate 4

Related Commands:

modify console

3.1.11 show debug mode

Display debug mode

show  debug  mode

Syntax Description:

This command is only used for development and testing.

Sample Display:

cli> show debug mode

debug mode 0

Related Commands:

modify debug mode

3.1.12 show version

Display ERT-2501 version information

show  version

Usage Guidelines:

Different version of firmware may have different function, you can know the function or feature
this router supports by checking its version information.
This command is able to display the following:
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© System Ident System Identification

© System Version System Version

© Release Date Release Date

© Installed Option Installed Option

© Serial Number Serial Number

© CLI Version Command Line Interface Version

Sample Display:

cli> show version

System Ident ERT-2501 System Version 05.09.01

Release Date 8-1-2000 Installed Option a

Serial Number 010203 CLI Version    V1.0.7 Aug 08 2000

3.2 Port Configuration Commands

3.2.1 Physical Port configuration Commands

Includes:

modify line parameters

show line parameters

3.2.1.1  modify line parameters

Modify physical port configuration

modify  line  parameters  line [ speed  speed  |  encaps  encaps  |  itype

itype  |  intnum  intnum  |  ioaddr  ioaddr  |  memaddr  memaddr ]

Syntax Description:

line Name of physical port, it may be Ethernet port, LAN, or the WAN port:

Port1, Port2.

speed Physical connection speed, unit is bps. Range¡ G9600, 14400, 19200, 28800,

38400, 57600, 64000, 115200, 128000, 256000, 512000, 1544000,

2048000. This parameter only applies to WAN port configuration.

encaps IPX packet type: V2, 802.3 or 802.2. This parameter only applies to the

Ethernet port. V2 is the Ethernet standard Ethernet Version 2.0

established by DIX. This parameter only specifies IPX packet type of Data

Link Layer. The IP packet type of Data Link Layer is fixed to V2.
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itype Connection Type¡ GRS-232, RS-422, RS-485, V.35.  This parameter only

applies to WAN port.

intnum Interrupt number in hexadecimal format.

ioaddr I/O address in hexadecimal format.

memaddr Memory address in hexadecimal format.

Default:

Default value of Ethernet Port is : encaps=802.3¡ Bintnum=0¡ Bioaddr=0¡ Bmemaddr=0¡ C

The default value of WAN Port are : speed=28800¡ Bitype=RS-232¡ Bintnum=0¡ B

ioaddr=0¡ Bmemaddr=0¡ C

Usage Guidelines:

Users should configure ERT-2501 according to connection status and usage.

To obtain the optimized performance, please check the maximum connection speed of each

interface shown as the following:

       Connection Type      Maximum Connection Speed

         V.35                   T1 or E1

        RS-232                   64 kbps

        RS-422                  T1 or E1

        RS-485                  T1 or E1

By the way, if WAN port 1 is set to T1 connection speed, the connection speed of WAN port 2 must not
more than 256k bps. The total connection speed should not more than 2M bps.

Sample Display:

Modify physical port Port1 to connection speed 57600, connection type as RS-232.

cli> modify line parameters port1 speed 57600 itype rs-232

Related Commands:

     show line parameters

3.2.1.2 show line parameters

Display physical port parameters

show  line  parameters  [ line  line ]

Syntax Description:

line  Name of Physical Port
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Default:

      If do not specify the port name, it will display all the parameters of all physical ports.

Usage Guidelines:

     This command displays the following information:

© Physical Port Name of Physical Port

© Speed Connection speed

© WAN Protocol WAN Protocol

© IPX Encaps     IPX Encapsulation type

© Interface Type Connection Type

© Interrupt Num Interrupt Number

© Mem Address Memory Address

© IO Address I/O Address

Sample Display:

     To display physical port Port1 parameters:

cli> show line parameters line port1

Physical Port port1 Interface Type RS-232

Speed 57600 Interrupt Num 0

WAN Protocol Mem Address 0

IPX Encaps 802.3 IO Address 0

Related Commands:

modify line parameters

3.2.2  Logical Port Configuration Commands

The logical port configuration commands include

add lport parameters

delete lport parameters

modify lport parameters

show lport parameters

show lport statistics

3.2.2.1 add lport parameters

Add a logical port

add  lport  parameters  lport  line [ priority  priority  |  circuit  circuit | phone

phone  |  idle  idle  |  bkpri  bkpri  |  loadbal  loadbal  | compress  compress ]
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Syntax Description:

lport Name of Logical port (Only the physical port set as Frame Relay can be

assigned multiple logical port, Maximum=23.)

line Name of physical Port, it can be Ethernet port: LAN or WAN port: Port1,

Port2.

priority Priority. Range: 0 - 255

circuit circuit usage: normal, dial-on-demand or backup

phone Dial String, 40 digits maximum.

idle Idle time. Range: 10 – 1200 seconds.

bkpri Backup port (logical), only used when circuit type is set to backup.

loadbal load-balancing, value : y or n .

compress Data compress, value : y or n.

Default:

When ERT-2501 is set to default, priority =0, Circuit type =Normal, dial string =none, idle time

=300, backup logical port =none, load balance = No, data compress = No.

Usage Guidelines:

© The default mapping of physical and logical ports are shown as following:

            

         Physical Port      Corresponding Logical Port

     Ethernet port    LAN           eth0

DB25 WAN  Port    Port1 wan1

DB25 WAN  Port    Port2 wan2

Suggestion : Keep these default names in order to keep the consistency of ERT-2501 in

your network topology.

© Only the physical port set as Frame Relay can be assigned multiple logical port (the

maximum is 23), and the physical port configured as PPP or HDLC can be assigned only

single logical port.

© Highest Priority is 0

© Dial-on-Demand only can be used with HDLC or Async PPP connection.

When use HDLC, Dial-on-Demand can only be used to connect ERT-2501s.

© When use “show lport parameters” command, only the prior 18 characters can be seen, but

users can see longer dial-up string in NetGrip setting.

© If circuit parameter is set as backup, “bkpri” parameters must be set also.

© Compression algorithm is only applicable between ERT-2501s. When using compression,

connection speed should be set to 64kbps or slower. (Compression will be forbidden while

connection speed is faster than 64kbps.)
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Sample Display:

Add logical port WAN3 on physical port Port1, and configure the line usage as backup line, and

the backup port is WAN1.

cli> add lport parameters wan3 port1 circuit backup bkpri wan1

      

Related Commands:

     modify lport parameters, delete lport parameters, show lport parameters

3.2.2.2  delete lport parameters

Delete logical port

delete  lport  parameters  lport

Syntax Description :

     lport  name of logical port

Usage Guidelines:

     User may delete logical ports while the logical port is no longer used.

Sample Display:

Delete logical port 3

cli> delete lport parameters wan3

      

Related Commands:

     add lport parameters, modify lport parameters,  show lport parameters

3.2.2.3  modify lport parameters

Modify settings of logical port

modify  lport  parameters  lport [ line  line | priority  priority | circuit  circuit  | phone

phone | idle  idle | bkpri  bkpri | loadbad  loadbad | compress  compress]

Syntax Description :

     Same as the command “add lport parameters”

Usage Guidelines:

Users are not only able to modify the settings of a logical port, but also to configure the
corresponding physical port.
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Sample Display:

Modify the priority of logical port WAN3 to be 1, dial string to be  AT&S1&C1&D2&S0

cli> modify lport parameters wan3 priority 1 phone AT&S1&C1&D2&S0=1

Related Commands:

     add lport parameters, delete lport parameters, show lport parameters

3.2.2.4  show lport parameters

Display configuration parameters of logical port

show  lport  parameters [ lport  lport ]

Syntax Description:

     lport  name of logical port

Default:

      If do not specify the port name, it will display all the parameters of all logical ports.

Usage Guidelines:

This command can display the following message:

© Logical Port Logical Port Name

© Physical Port Corresponding Physical Port

© Backup for Port Port be backup

© Priority Priority

© Load Balance Enable Load Balance or not

© Circuit Line usage

© Compression Data compression or not

© Dial String Dial string

© Idle Time Idle time

Sample Display:

Display parameters of logical port WAN 3

cli> show lport parameters wan3

     Logical  Port wan3 Circuit Backup

     Physical Port Port1 Compression No

     Backup for Port wan1 Dial String 1AT7M1ATDT201

     Priority 1 Idle Time 300

     Load Balance No
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Related Commands:

     add lport parameters, modify lport parameters, delete lport parameters

3.2.2.5  show lport statistics

Display logical port statistics information

show  lport  statistics

Usage Guidelines:

This command can display the following information:

© lport Name of logical port

© ifInUcastPkts The number of subnetwork-unicast packets delivered to a higher-layer
protocol.

© ifInDiscards Number of inbound packets for which no problems were encountered to
prevent their continued processing, but which were discarded (for example, for lack of buffer
space).

© ifInUnknownProto The number of packets received via the interface which were discarded
because of an unknown or unsupported protocol.

© ifOutUcastPkts The number of unicast packets transmitted.

© ifOutDiscards Number of outbound packets for which no problems were encountered
to prevent their continued processing, but which were discarded (for example, for lack of
buffer space).

© ifOutQLen The length of the output packet queue (in packets).

© MtuExceededDisca Total number of frames the interface discard due to exceed the MTU
(maximum transfer Unit).

© InFrames The number of frames received in logical port

© InDiscards Number of inbound packets for which no problems were encountered to
prevent their continued processing, but which were discarded (for example, for lack of buffer
space).

© ifInOctets The total number of octets received on the interface, including framing
characters.

© ifInNUcastPkts The number of non-unicast (i.e., subnetwork- broadcast or subnetwork-
multicast) packets delivered to a higher-layer protocol.

© ifInErrors The number of inbound packets that contained errors preventing them
from being deliverable to a higher-layer protocol.

© ifOutOctets The total number of octets transmitted out of the interface, including
framing characters.

© ifOutNUcastPkts The total number of packets that higher-level protocols requested be
transmitted to a non- unicast (i.e., a subnetwork-broadcast or subnetwork-multicast) address,
including those that were discarded or not sent.

© ifOutErrors The number of outbound packets that could not be transmitted because
of errors.

© DelayExceededDis The number of frames discarded by this port due to excessive transit
delay through the bridge.

© ForwardTransitio Number of transitions from Blocking to Forwarding due to STP
reconfiguration.

© OutFrames The number of frames transmitted in logical port
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Sample Display:

cli> show lport statistics

lport wan2 ifInOctets 0
ifInUcastPkts 0 ifInNUcastPkts 0
ifInDiscards 0 ifInErrors 0
ifInUnknownProto 0 ifOutOctets 0
ifOutUcastPkts 0 ifOutNUcastPkts 0
ifOutDiscards 0 ifOutErrors 0
ifOutQLen 8 DelayExceededDis 0
MtuExceededDisca 0 ForwardTransitio 0
InFrames 0 OutFrames 0
InDiscards 0

lport wan1 ifInOctets 0
ifInUcastPkts 0 ifInNUcastPkts 0
ifInDiscards 0 ifInErrors 0
ifInUnknownProto 0 ifOutOctets 0
ifOutUcastPkts 0 ifOutNUcastPkts 0
ifOutDiscards 0 ifOutErrors 0
ifOutQLen 8 DelayExceededDis 0
MtuExceededDisca 0 ForwardTransitio 0
InFrames 0 OutFrames 0
InDiscards 0

lport  eth0 ifInOctets 10916920
ifInUcastPkts 31036 ifInNUcastPkts 4461
ifInDiscards  0 ifInErrors   0
ifInUnknownProto 0 ifOutOctets 22380
ifOutUcastPkts 128 ifOutNUcastPkts 121
ifOutDiscards 0 ifOutErrors   0
ifOutQLen 64 DelayExceededDis   0
MtuExceededDisca 0 ForwardTransitio   0
InFrames 35497 OutFrames   0
InDiscards 2930

 3.3 WAN Protocol Configuration Commands

3.3.1 PPP Commands

PPP Commands:

add  ppp  line

delete  ppp  line

modify  ppp line

show  ppp  line
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3.3.1.1  add ppp line

Configure WAN protocol as PPP

add  ppp  line  line [ maxc  maxc | maxf  maxf | maxt  maxt  |  errth  errth  |

events  events  |  tpoll  tpoll  |  trest  trest ]

Syntax Description :

line Physical port name

maxc Maximum configure, range :1-255

maxf Maximum failure, Range :1-255

maxt Maximum terminate, range :1-255

errth Error threshold, range : 1-10

events Event counts, range : 1-10

tpoll Polling timer, range : 1-3600¡ ]Second¡ ^

trest Restart timer, range : 1-3600¡ ]second¡ ^

Default Value

When ERT-2501 is set to default setting, Max. Configure =10, Maximum Error=10, Maximum

Terminate =2, Error threshold=3, Event Counts =5, Poll Timer =10 sec, Restart Timer =3 sec.

Usage Guidelines:

This command is used to configure parameters of PPP protocol.

Sample Display:

Configure WAN protocol of physical port Port2 as PPP, and set the Max. Configure =10,

Maximum Failure=15, Error Threshold=5, Event Counts=5, Restart timer =200 sec.

cli> add ppp line port2 maxc 10 maxt 15 errth 5 events 5 tpoll 200

Related Commands:

     modify ppp line, delete ppp line, show ppp line

3.3.1.2  delete ppp line

Delete settings of PPP protocol.

delete ppp line line

Syntax Description:

     line  Name of physical port
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Usage Guidelines:

User may delete PPP settings when PPP protocol is no longer used.

Sample Display:

Delete PPP protocol of physical port Port1

cli> delete ppp line port1

Related Commands:

add ppp line, modify ppp line, show ppp line

3.3.1.3  modify ppp line

Modify settings of PPP on physical (logical) port

modify  ppp  line  line [ maxc maxc | maxf maxf  |  maxt maxt | errth errth  |  events

events | tpoll  tpoll  |  trest  trest ]

Syntax Description:

     Same as command “add ppp line “.

Usage Guidelines:

This command can be used only when the port has been configured as PPP protocol.

Sample Display:

Modify PPP settings of physical port Port1, set Max. Configure =50, Maximum Terminate=30,

Event Counts=10, and the Polling timer=300 sec.

cli> modify ppp line port1 maxc 50 maxt 30 events 10 tpoll 300

Related Commands:

     add ppp line, del ppp line, show ppp line

3.3.1.4  show ppp line

Display PPP settings of a specific port

show  ppp  line  line

Syntax Description :

     line  Name of physical port
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Usage Guidelines:

This command can be used to display the following messages :

© Address Format Address Format

© Max. Configure Maximum Configure

© Max. Failure Maximum Failure

© Max. Terminate Maximum Terminate

© Error Threshold Error Threshold

© Events Events count

© Poll Timer Poll Timer

© Restart Timer Restart Timer

Sample Display:

Display PPP parameters of physical port Port1

cli> show ppp line port1
Address Format 1 Error Threshold 3

Max. Configure 10 Events 5

Max. Failure 10 Poll Timer 10

Max. Terminate 2 Restart Timer 3

Related Commands:

add ppp line, modify ppp line, delete ppp line

 3.3.2  HDLC Configuration Commands

HDLC configuration commands Include:

add  hdlc  line

add  hdlc  lport

delete  hdlc  line

delete  hdlc  lport

modify  hdlc  lport

show  hdlc  line

show  hdlc  lport

3.3.2.1  add hdlc line

Set WAN protocol of physical interface to be HDLC

add  hdlc  line  line  [ stype  stype ]

Syntax Description:

line    Name of physical port

stype   Station type: dte or dce
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Default:

Default setting of stype is dte.

Usage Guidelines:

This command is used to configure data link layer protocol of physical port to be

HDLC. Only DTE device can be utilized for the time being.

Sample Display:

Configure WAN protocol of physical port 1 as HDLC, and the station type as DTE.

cli> add hdlc line port1 stype dte

Related Commands:

delete hdlc line, show hdlc line

3.3.2.2  add hdlc lport

Configure WAN protocol of logical port as HDLC

add  hdlc  lport  lport [ ht1  ht1 |  hn2  hn2  | wsize  wsize | psize  psize ]

Syntax Description:

lport Name of logical port

ht1 Polling timer

hn2 Maximum Error

wsize Window Size

psize Packet Size

Default:

When ERT-2501 is set to default, ht1=3000, hn2=20, wsize=7, psize=576.

Usage Guidelines:

This command is used to configure data link layer protocol of physical port to be HDLC.

Sample Display:

Configure WAN protocol of logical port as HDLC, and the Polling Timer =1 sec,

Maximum Errors=20.

cli> add hdlc lport wan1 ht1 1 hn2 20

Related Commands:

      modify hdlc lport, delete hdlc lport, show hdlc lport
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3.3.2.3  delete hdlc line

Delete HDLC settings of physical port.
delete  hdlc  line  line

Syntax Description:

line  Name of physical port.

Usage Guideline:
This command can be used to delete HDLC settings of physical port.

Sample Display:
Delete HDLC settings of physical port port1

cli> delete hdlc line port1

Related Commands:

add hdlc line, show hdlc line

3.3.2.4  delete  hdlc  lport

Delete HDLC settings of logical port

delete  hdlc  lport  lport

Syntax Description:

      lport  Name of logical port

Usage Guidelines:

This command is used to delete HDLC settings of logical port.

Sample Display:

Delete HDLC settings of the logical port WAN1

cli> delete hdlc lport wan1

Related Commands:

      add hdlc lport, modify hdlc lport,  show hdlc lport

3.3.2.5  modify  hdlc  lport

Modify HDLC settings of logical port
modify  hdlc  lport  lport [ ht1  ht1  |  hn2  hn2  |  wsize wsize  | psize psize]

Syntax Description:

      Same parameter usage as command “add hdlc lport” .



- 57 -

Usage Guidelines:
This command is used to modify HDLC settings of logical port.

Sample Display:

Modify HDLC settings of logical port WAN1, Maximum Error=10, Window Size =16 and the

packet size =576.

cli> modify hdlc lport wan1 hn2 10 wisze 16 psize  576

Related Commands:

      add hdlc lport, delete hdlc lport, show hdlc lport

3.3.2.6  show  hdlc  line

Display HDLC settings of logical port
show  hdlc  line  line

Syntax Description:

     line   Name of physical port

Usage Guidelines:

This command is used to display station type of physical port.

Sample Display:
Display HDLC parameters of physical port Port1.

cli> show hdlc line port1

Station  Type       DTE

Related Commands:

add hdlc line, delete hdlc line.

3.3.2.7   show  hdlc  lport

Display HDLC parameters of logical port.
show  hdlc  lport  lport

Syntax Description:

     lport  Name of logical port.

Usage Guidelines:

This command is used to display the following information:
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© Polling Timer Polling Timer

© Window Size Window Size

© Max. Errors Maximum Errors

© Packet Size Packet Size

For example
Display HDLC parameters of physical port Port1.
cli> show hdlc lport wan1
Polling  Timer 3000 Window  Size 7

Max. Errors 20 Packet  Size 576

Related Commands:

      add hdlc lport, modify hdlc lport, delete hdlc lport

3.4  Frame Relay Configuration Commands

3.4.1 Frame Relay configuration commands Include:

add  fr  line

add  fr  lport

delete  fr  line

modify  fr  line

modity  fr  lport

show  fr  line

show  fr  lport

3.4.1.1  add  fr  line

Configure WAN port protocol of physical port as Frame Relay.

add  fr  line  line [ addrfmt  addrfmt  |   addrlen  addrlen  |  dlcmi  dlcmi  |

n1  n1  |  n2  n2  |  n3  n3  |  t1  t1  |  t2  t2 ]

Syntax Description:

line Name of physical port.

addrfmt Address format: Q921 or Q922

addrlen Address length

dlcmiFrame Relay management interface: LMI, Anney-D or Offn1 Polling Cycle,

range: 1-255

n2 Maximum Errors, range: 1-10

n3 Maximum Events, range: 1-10
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t1 Polling Timer, range: 5-30 (sec)

t2 Network Timer, range: 5-30 (sec)

Default:

When ERT-2501 is set to default, the Address Format =Q921, Address Length=2,

Frame Relay Management Interface=LMI, Polling Cycle =6, Maximum Errors = 2,

Maximum Events = 4, Polling Timer=10 sec, and the Network Timer =15 sec.

Usage Guidelines:

© The N1 parameter specifies the ratio of normal STATUS ENQUIRY messages to full

STATUS ENQUIRY messages. The full STATUS ENQUIRY message is used by the

router to request a full STATUS message from the network. The full STATUS

message is the message that contains the status of all DLCs known to the network.

Since the status of DLCs is not expected to change frequently and the full STATUS

message is longer than the normal STATUS message, it is usual to set N1 to a

number greater than 1 to ensure that excess bandwidth is not devoted to LMI

messages. The value n1 must be a number between 1 and 255 inclusive, and defaults

to 6.

© The N2 parameter specifies the number of error events in the last N3 events that will

cause an alarm condition to be flagged. An event in this context is the reception of a

reply to the STATUS ENQUIRY message sent by the router. An error event is a

timeout before this message is received, or a reply being received with an incorrect

format. The value n2 must be a number between 1 and 10 inclusive, and must be less

than or equal to the value of N3. The default value for N2 is 2.

© The N3 parameter specifies the number of events used to determine alarm conditions

and the negation of the alarm condition. If N2 out of the last N3 events are in error, an

alarm is set. The alarm is cleared again when N3 events are received without error.

The value n3 must be a number between 1 and 10 inclusive, and must be greater than

or equal to the value of N2. The default value for N3 is 4.

© Note the dependence of N2 and N3 on each other. Any value may be specified for N2

and N3, as long as at the end of processing the command line, the value of N2 is less

than or equal to the value of N3.

© The T1 parameter specifies the interval, in seconds, between STATUS ENQUIRY

messages transmitted by the router to the Frame Relay network.. The STATUS

ENQUIRY message is the basic poll message of the LMI dialogue. The value t1 must

be a multiple of 5 and must fall between 5 and 30 inclusive. The default value for T1 is

10. The change to the value of T1 takes place immediately, although the effect only

takes place after the next STATUS ENQUIRY message is sent to the network..
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© The values of T1 and N1 combine to determine how often full STATUS ENQUIRY

messages are sent to the network. The minimum value for the period between full

STATUS ENQUIRY messages is 5 seconds and the maximum value is 7650 seconds

(255 x 30 seconds).

Sample Display:

Configure WAN protocol of physical port Port1 as Frame Relay, and set the Address

Format =Q921, Address length=2, Frame Relay Management Interface = LMI, Polling

Cycle=10, Polling Timer =5 sec, and Network Timer =10 sec.

cli> add fr line port1 addfmt q921 addrlen 2 dlcmi lmi n1 10 t1 5 t2 10

Related Commands:

     modify fr line, delete fr line, show fr line

3.4.1.2  add  fr  lport

Configure Frame Relay to logical port.

add  fr  lport  lport  dlci [ frcir  frcir  |  frcbir  frcbir  |  frtc  frtc ]

Syntax Description:

lport Name of logical port.

dlci data link connection identification, range: 16-1007

frcir Frame Relay Committed Information Rate, in bps

frcbir Frame Relay Committed Burst Information Rate, in bps

frtc Measure Rate Interval, in sec

Default:

When ERT-2501 is set to default, DLCI =0, Committed Information Rate, and Committed Burst

Information Rate = line speed, and the Measure Rate Interval=4

Usage Guidelines:

This command is used to add Frame Relay to logical port.

Sample Display:

Add a Frame Relay of logical port WAN1, and set DLCI=16, and the CIR, CBIR=57600.

cli> add fr lport wan3 16 frcir 57600 frcbir 57600

Related Commands:

     modify fr lport, show fr lport
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3.4.1.3  delete  fr  line

Delete Frame Relay configuration from physical port.

delete  fr  line  line

Syntax Description:

line  Name of physical port.

Usage Guidelines:

This command is used to delete Frame Relay settings of physical port.

Sample Display:

Delete Frame Relay settings of physical port Port1.

cli> delete fr line port1

Related Commands:

      add fr line, modify fr line, show fr line

3.4.1.4  modify  fr  line   

Modify Frame Relay parameters of physical port.

modify  fr  line  line [ addrfmt  addrfmt  |   addrlen  addrlen  |  dlcmi  dlcmi  |  n1  n1

|  n2  n2  |  n3  n3  |  t1  t1  |  t2  t2 ]

Syntax Description:

     Same parameter usage as the command : “add fr line”

Usage Guidelines:

This command is used to modify Frame Relay parameters of physical port.

Sample Display:

Modify Frame Relay Parameters of physical port Port1, and set Address Format =Q922, Polling

Cycle = 15, Maximum Errors=3, and the Polling Timer=10.

cli> modify fr line port1 addrfmt q922 n1 15 n2 3 t1 10

Related Commands:

      add fr line, delete fr line, show fr line

3.4.1.5  modify  fr  lport

Modify Frame Relay parameters of logical port.

modify  fr  lport  lport [ dlci  dlci  |  frcir  frcir  |  frcbir  frcbir  | frtc  frtc ]
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Syntax Description:

     Same parameter usage as commands : “add fr lport” .

Usage Guidelines:

This command is used to modify Frame Relay configuration of logical port.

Sample Display:

Modify Frame Relay parameters of logical port WAN1, and set DLCI =50, CIR=CBIR=57600bps.

cli> modify fr lport wan1 dlci 50 frcir 57600 frcbir 57600

Related Commands:

add fr lport, show fr lport

3.4.1.6  show  fr  line

Show Frame Relay parameters of physical port.

show  fr  line  line

Syntax Description:

     line  Name of physical port

      

Usage Guidelines:

This command is used to display the following messages : ¡ G

© Address Format Address Format

© Address Length Address Length

© DLCMI Frame Relay Management Interface

© Polling Cycle Polling Cycle, N1

© Max. Errors Maximum Errors, N2

© Max. Events Maximum Events, N3

© Polling Timer Polling Timer, T1

© Network Timer Network Timer, T2

Sample Display:

Display Frame Relay parameters of physical port Port2

cli> show fr line port2
Address Format Q921 Max. Errors 2

Address Length 2 Max. Events 4

DLCMI LMI Polling Timer 10

Polling Cycle 6 Network Timer 15

Related Commands:

     add fr line, modify fr line, delete fr line
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3.4.1.7   show  fr  lport

Show Frame Relay parameters of logical port.

show  fr  lport  lport

Syntax Description:

     lport  Name of logical port

Usage Guidelines:

This command is used to display the following messages:

© DLCI Data Link Connection Indicator

© Measure Rate Measure Rate Interval

© Committed Rate Committed Information Rate, CIR

© Burst Rate Committed Burst Information Rate, CBIR

Sample Display:

Display Frame Relay parameters of logical port WAN1

cli> show fr lport wan1
DLCI 0 Committed Rate 64000

Measure Rate 4 Burst Rate 64000

Related Commands:

add fr lport,  modify fr lport

3.4.2  X.25 Configuration Commands :

X.25 Configuration commands include the following:

add  x25  line

add  x25  lport

add  x25  map

clear  x25  lport

delete  x25  line

delete  x25  lport

delete  x25  map

modify  x25  line

modify  x25  lport

modify  x25  map

reset  x25  lport

restart  x25  lport

show  x25  line

show  x25  lport

show  x25  map

3.3.4.1  add  x25  line

Configure WAN protocol of physical port as X.25

add  x25  line  line [ xt1  xt1 |  xt2  xt2 |  xn1  xn1 |  xn2  xn2 |  xk  xk ]
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Syntax Description:

line Name of physical port

xt1 LAPB (Link Access Procedure Balanced) parameter T1

xt2 LAPB parameter T2

xn1 LAPB parameter N1

xn2 LAPB parameter N2

xk LAPB parameter K

Default:

When ERT-2501 is set to default, T1=3sec, T2=1sec, N1=1032, N2=16, K=7.

Usage Guidelines:

LAPB Parameters:

© t1: Unit in second, This specifies the maximum time to wait for acknowledgment of a

frame. Resend the frame if exceed this time.

© t2: Unit in seconds, This specifies the maximum time to wait before sending an

acknowledgment for a sequenced frame.  A value of zero means there will be no delay in

acknowledgement generation.

© n1: Unit =bit. The N1 frame size used for the maximum number of bits in a frame.

© n2: The N2 retry counter used for this interface.  This specifies the number of times a

frame will be resent after the T1 timer expires without an acknowledgement for the frame.

© k: The window size for this Interface.  This is the maximum number of unacknowledged

sequenced frames that may be outstanding from this DTE at any one time.

Sample Display:

Configure WAN port protocol of physical port Port1 as X.25. T1=8, T2=3, N1=1500, N2=5, K=7.

CLI> add x25 line port1  xt1 8  xt2 3  xn1 1500  xn2 5  xk 7

Related Commands:

     modify x25 line, delete x25 line, show x25 line

3.3.4.2  add  x25  lport

Configure X.25 parameters of logical port.

add  x25  lport  lport  [ local_x25addr local_x25addr  |  htc htc  |  ltc ltc |  xidle xidle  |

t20 t20  |  t21 t21  |  t22 t22  |  t23 t23  |  dbit dbit  |  faciswitch faciswitch  |

win_send win_send  |  win_recv win_recv |  plen_send plen_send  |  plen_recv plen_recv

|  thro_class thro_class |  relaydelay relaydelay  |  cugs cugs  |  cugio  cugio  |  bcug
bcug  ]

Syntax Description:

lport Name of logical port

local_x25addr Local X.25 address

htc Highest two-way channel number

ltc Lowest two-way channel number

xidle SVC Idle time

dbit Dbit set
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t20 Restart timer

t21 Value of the Call Request timer

t22 Value of the Reset Request timer

t23 Value of the Clear Request timer

faciswitch Facilities Switch

win_send Transmit window size

win_recv Receive window size

plen_send Transmit packet length

plen_recv Receive packet length

thro_class Class of throughput

relaydelay Relay delay time

cugs    Closed User Groups (CUG) number

cugio    CUG with IO flag

bcug    Bilateral CUG flag

Default:

When ERT-2501 is set to default, htc=16, ltc=1, xidle=20 sec, dbit=0, t20=180 sec, t21=200 sec,

t22=180 sec, t23=180 sec, faciswitch=0, win_send=2, win_recv=2, plen_send=7, plen_recv=7,

thro_class=0, relaydelay=0, cugs=0, cugio=0, bcug=0¡ C

Usage Guidelines:

© Basic parameters :

local_x25 addr Local X.25 address, an address composed of 1-15 digits. Each X.25 leased line

will be assigned such an address.
htc Highest Two-way Channel. User have to specify the range of available Logical

Channel Number (LCN) according to subscription contract.  The typical range
is 1~16.  The default setting of htc is 16 and maximum setting is 64.

ltc Lowest Two-way Channel, default value=1, minimum=1, and htc>=ltc (please
refer to htc.)

xidle Switched Virtual Circuit (SVC) idle time. If SVC idle time exceeds the value,
SVC will be closed.

Dbit Dbit setting. If Dbit of data packet is set to 0, the data packet is acknowledge by
local end.  If it is set to 1, the data packet is acknowledge by remote end.

© Optional facilities parameters:
faciswitch Switch of optional facilities. 1 means that SVC call request packet will carry a

facilities field to negotiate with remote DTE.  0 means that SVC call request
packet will not carry this field and use the default settings.

win_send Transmission window size, range from 2 to modulus –1.

win_recv Reception window size, range from 2 to modulus –1.

plen_send Transmission packet length, range from 4 to 12.  Default value=7 i.e. sent packet
length = 128 bytes¡ C

plen_recv Reception Packet length, range from 4 to 12.   Default value = 7 i.e. Received
Packet length=128 bytes

thro_class¡ GThroughput class, represents the maximum transmission speed on Virtual Circuit.
It should be higher than the connection speed of Data Link Layer.  The
throughput class is coded by an octet ( separated to two 4-bit, in hexadecimal)
The first represents called DTE, the second represents calling DTE.  Their
mappings are as following:
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 HEX Transmitting Speed¡ ]bit/s¡ ^

3 75

4 150

5 300

6 600

7 1200

8 2400

9 4800

a 9600

b 19200

c 48000
The typical value is aa (in hexadecimal) which mean the called and calling DTE
are both set to 9600bit/s.  The default is 0 which mean that do not negotiate this
value.

relaydelay¡ GRelay delay, The delay of network transmission in millisecond.  This value can be
specified on call request packet of the SVC.  The default is 0, mean do not
specify this value.

cugs¡ G    Close User Group Number.  Range from 1-9999 in decimal.  This service needs
to be subscribed with service provider.  The default value is 0, mean disable this
service.  The following value is applicable only if cugs is not 0.

cugio¡ G    Close User Group with I/O flag.  0: without Incoming/Outgoing access.  1:
Outgoing access.  2: Incoming access.

bcug¡ G    Bilateral Close User Group flag.  0: do not subscribe the service.  1: have
subscribed the service. The mapping of CUG with the corresponding X.25
address of remote DTE is shown on X.25 address mapping table.

Sample Display:

Configure X.25 parameter of logical port WAN1, and set HTC=16, Relay Delay = 2 ms and others

are set as default value.

CLI> add  x25  lport wan1  htc 16  relaydelay 2

Related Commands:

     modify x25 lport, delete x25 lport, show x25 lport

3.3.4.3  add  x25  map

Add X.25 address mapping entry.

add  x25  map  destip  remote_x25addr  pvc_flag  lcn  cug

Syntax Description:

destip WAN port IP address of Destination DTE

remote_x25addr X.25 address of Destination DTE

pvc_flag PVC Flag, configure Virtual Circuit type of destination address

lcn Logical Channel Number

cug Closed User Groups number of Destination DTE
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Default:

When ERT-2501’ s configuration is set to default, its destip=0, remote_x25addr=0, pvc_flag=0,

lcn=0, cug=0.

Usage Guidelines:

destip¡ G WAN port IP address of Destination DTE

remote_x25addr X.25 address of destination DTE, which is composed of 1 to 15 digits.

pvc_flag PVC flag, configuration the virtual circuit type of destination address.

1=PVC, 0=SVC.

lcn Logical Channel Number, if vcflag=1, i.e. PVC assigns its logical channel

number( this value is assigned by your service provider when subscribe

PVC),  range = 1 ~ 64.  If vcflag=0, i.e. SVC is not required to assigned the

logical channel number, lcn=0.

cug Close User Groups number of Destination DTE, range from 1~9999, default

value = 0 means that there is no CUG number.

Sample Display:

Add X.25 address mapping entry, destination IP address = 10.0.0.2, X.25 address = 2101,  X.25

address = 2101, PVC flag =1, Logical Channel Number lcn = 16, CUG number of Destination

DTE = 2

CLI> add  x25  map  10.0.0.2  2101  1  16  2

Related Commands:

     modify x25 map, delete x25 map, show x25 map

3.3.4.4  clear  x25  lport

Clear SVC

clear  x25  lport  lport  lcn

Syntax Description:

lport Name of logical port

lcn Logical Channel Number

Usage Guidelines:

This command is used to clear connection of switched virtual circuit.

Sample Display:

Clear lcn=16 SVC of logical port wan1

CLI> clear x25 lport wan1 16

Related Commands:

reset x25 lport, restart x25 lport
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3.3.4.5  delete  x25  line

Delete X.25 configuration of physical port.

delete  x25  line  line

Syntax Description:

line Name of physical port.

Hint ;

This command is used to delete X.25 configuration of physical port.

Sample Display:

Delete X.25 configuration of physical port Port1.

CLI> delete x25 line port1

Related Commands:

     add x25 line, modify x25 line, show x25 line

3.3.4.6  delete  x25  lport

Delete X.25 parameters of logical port.

delete  x25  lport  lport

Syntax Description:

lport Name of logical port.

Usage Guidelines:

This command is used to delete the X.25 parameters of logical port.

Sample Display:

Delete X.25 parameters of logical port WAN1.

CLI> delete x25 lport wan1

Related Commands:

     add x25 lport, modify x25 lport, show x25 lport

3.3.4.7  delete  x25  map

Delete X.25 address mapping entry.

delete  x25  map  destip

Syntax Description:

destip IP address of destination DTE.
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Usage Guidelines:

This command is used to delete the address mapping entry.

Sample Display:

Delete the X.25 address mapping entry of IP: 10.0.0.2.

CLI>  delete  x25  map  10.0.0.2

Related Commands:

     add x25 map, modify x25 map, show x25 map

3.3.4.8  modify  x25  line

Modify X.25 parameters of physical port.

modify  x25  line  line [ xt1  xt1 | xt2  xt2 | xn1  xn1 | xn2  xn2 | xk  xk ]

Syntax Description:

Same parameter usage as the command: “add x25 line” .

Usage Guidelines:

This command is used to modify the parameters of physical port.

Sample Display:

Modify X.25 parameters of physical port Port1, and set T1=6, T2= 9, K=6

CLI> modify x25 line port1 xt1 6 xt2 9 xk 6

Related Commands:

     add x25 line, delete x25 line, show x25 line

3.3.4.9  modify  x25  lport

Modify X.25 parameters of logical port.

modify x25  lport lport  [ local_x25addr local_x25addr  |  htc htc  |  ltc ltc  |  xidle xidle

|  t20 t20  |  t21 t21  |  t22 t22  |  t23 t23 |  dbit dbit |  faciswitch faciswitch  |

win_send win_send  |  win_recv win_recv |  plen_send plen_send  |  plen_recv plen_recv

|  thro_class thro_class |  relaydelay relaydelay  |  cugs cugs  |  cugio cugio  |  bcug

bcug  ]

Syntax Description:

Same parameter usage as command: “add x25 lport” .

Usage Guidelines:

This command is used to modify X.25 parameters of logical port.
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Sample Display:

Modify X.25 parameters of logical port WAN1 and set htc=64, relaydelay=4ms, thro_class

=9600bit/s

CLI> modify  x25  lport  wan1  htc  64  relaydelay  4  thro_class  aa

Related Commands:

     add x25 lport, delete x25 lport, show x25 lport

3.3.4.10  modify  x25  map

Modify address mapping entry of X.25.

modify x25 map destip [ remote_x25addr remote_x25addr | pvc_flag  pvc_flag | lcn lcn  |

cug cug ]

Syntax Description:

Same parameter usage as command: “  add x25 map “.

Usage Guidelines:

This command is used to modify the address mapping of X.25 .

Sample Display:

Modify X.25 address mapping entry of IP (10.0.0.2), X.25 address=36168, logical channel

number (lcn) =20.

CLI>  modify  x25  map  10.0.0.2  remote_x25addr  36168  lcn  20

Related Commands:

     add x25 map, delete x25 map, show x25 map

3.3.4.11  reset  x25  lport

Reset PVC, SVC

reset  x25  lport  lport  lcn

Syntax Description:

lport Name of logical port.

lcn Logical Channel Number

Usage Guidelines:

This command is used to reset PVC, SVC.

Sample Display:

Reset lcn=16 SVC of logical port WAN1.

CLI> reset x25 lport wan1 16

Related Commands:

     clear x25 lport, restart x25 lport
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3.3.4.12  restart  x25  lport

Restart logical port

restart  x25  lport  lport

Syntax Description:

lport Name of logical port.

Usage Guidelines:

This command can be used to restart logical port.

Sample Display:

Restart the virtual circuit of logical port WAN1.

CLI> restart x25 lport wan1

Related Commands:

     clear x25 lport, reset x25 lport

3.3.4.13  show  x25  line

Show X.25 parameters of physical port.

show  x25  line  line

Syntax Description:

line Name of physical port.

Usage Guidelines:

Please refer to the “add x25 line” command.

Sample Display:

Display X.25 parameters of physical port Port1.

CLI> show x25 line port1
LAPB_T1 8 LAPB_N1 1500

LAPB_T2 3 LAPB_N2    5

LAPB_K 7

Related Commands:

     add x25 line, delete x25 line, modify x25 line

3.3.4.14  show  x25  lport

Display X.25 parameters of logical port.

show  x25  lport  lport

Syntax Description:

lport Name of logical port.
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Usage Guideline:

Please refer to the “add x25 lport” command.

Sample Display:

Display X.25 parameters of logical port WAN1

CLI>  show  x25  lport  wan1
Local x25address 0 Win_send 2

Htc 64 Win_recv 2

Ltc 1 Plen_send 7

Idle Time 20 Plen_recv 7

Dbit 0 Thro_class aa

T20 180 Relaydelay 4

T21 200 Cugs 0

T22 180 Cugio 0

T23 180 bcug 0

Faciswitch 0

Related Commands:

     add x25 lport, delete x25 lport, modify x25 lport

3.3.4.15  show  x25  map

Display X.25 address mapping information.

show  x25  map  [ destip destip ]

Syntax Description:

destip WAN Port IP address of destination DTE.

Default:

If do not specify parameter, this command can be used to display all the X.25 address mapping

entries.

Usage Guidelines:

Please refer to “add x25 map” command.

Sample Display:

Display X.25 address mapping entry of destination IP(10.0.0.2)

CLI>  show  x25  map  10.0.0.2

Destination IP 10.0.0.2 Lcn  16

Remote x25address 2101 Cug        2

Pvc_flag  1

Related Commands:

     add x25 map, delete x25 map, modify x25 map
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3.4  Network Protocol Configuration Commands

3.4.1 IP Configuration Commands :

IP configuration commands include the following : ¡ G

add ip lport

add ip route

add iprip lport

delete ip lport

delete ip route

delete iprip lport

modify ip lport

modify ip route

modify iprip lport

show arp table

show icmp statistics

show ip lport

show ip route

show ip statics

show tcp statistics

show udp statistics

3.4.1.1  add ip lport

Configure the IP address of logical port.

add  ip  lport  lport  destip  maskip [  mtu  mtu  |  metric metric ]

Syntax Description:

lport Name of the logical port.

destip IP address of the logical port.

maskip Subnet mask

mtu Maximum Transmitting Unit, range : 1-1546

metric Measure count, range:1-15

Default:

      When ERT-2501’ s configuration is set to default, mtu=576, metric=1.

Usage Guidelines:

© Port’ s IP address and subnet mask, are in dotted decimal notation.

© For configuration convenience, it is required that any 2 ports on ERT-2501 must not be

assigned to the same subnet.
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Sample Display:

Configure logical port wan1 IP as 130.1.2.100, subnet mask = 255.255.255.0, mtu=1500,

metric=1

cli> add ip lport wan1 130.1.2.100 255.255.255.0 mtu 1500 metric 1

Related Commands:

     modify ip lport, delete ip lport, show ip lport

 3.4.1.2 add ip route

Add static IP route

add  ip  route  destip  gwip  maskip  metric

Syntax Description:

destip      Destination IP address

gwip       Gateway IP address

maskip     Subnet mask

metric      Measure count, range : 1-16

Usage Guidelines:
© The process of routing packets consists of selectively forwarding data packets from one

network to another. The router bases its decision to send the packet to a particular network
on the information it can learn dynamically from listening to the selected route protocol, as
well as the static information entered as part of the configuration process.

© The router maintains a table of routes which tells the router how to find a remote network or
host. The route table holds information about routes to destinations. A route is uniquely
identified by IP address, subnet mask, next hop IP address (gateway IP) and metrics.

© A list of routes is uniquely identified by its IP address and subnet mask.  When an IP
packet is received, the routing table is scanned to find the lowest metric route to the
destination. It is then forwarded to that route by sending it to the router specified by the next
hop. If no route exists the table is scanned for the default route (0.0.0.0) and forwarded as
before. If no direct route or default route exists, the packet is discarded and an ICMP
message to that effect is sent back to the source.

Sample Display:

Add a static IP route, destination IP=130.1.2.100, gateway=130.1.11.2, subnet mask =

255.255.255.0, and the metric=1

cli> add ip route 130.1.2.100  130.1.11.2  255.255.255.0  1

Related Commands:

         modify ip route, delete ip route, show ip route

 3.4.1.3 add iprip lport

Configure dynamic IP routing

add  iprip  lport  lport [ flags  flags  |  ripmetric  ripmetric  |  time  time  |  rtp  rtp ]
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Syntax Description:
lport Name of logical port.

flags Flags can be used to indicate whether allow sending , receiving RIP broadcasting
packets or not.  The available parameters are: send,listen = allow sending and
receiving, send = allow sending only, listen = allow receiving only, none = disable
both sending and receiving.

ripmetric Dynamic Routing Metric.

time Interval between RIP renewal broadcast, range : 5 – 3600(sec).

rtp IP Routing Protocol: RIP or None.

Default:

     When ERT-2501 is set to default, flags = SEND, LISTEN, ripmetric=1, time=30, rtp = RIP.

Usage Guidelines:
© This command is used to enable the dynamic routing function of logical port, and it only works

on the logical port that enables IP function.

© Dynamic IP route and static IP route can be adopted at the same time, but it is not
recommended. If dynamic IP route is not adopted, users have to create at least one route in
IP static route. It can have maximum 128 dynamic route entries in dynamic routing table, and
maximum 8 static route entries in IP static route table.

© Variable Length Subnet Masks¡ ]VLSM¡ ônly be supported on static route.

© RIP uses Hop Count to estimate the distance to destination host, this is called “Routing
Metric”. In RIP, The hop count to the network which router directly connects to is 0 (It is
defined as “1” in some protocol.). The hop count to the next reachable network is 1, and so
on. To limit the convergence time, RIP set the range of metric from 0 to 15, if hop count is
larger than 16 metrics, the distance will be treated as infinite.

© To improve performance, ERT-2501supports split horizon algorithm on RIP protocol, and it
adapts triggered update to refresh the routing information.

Sample Display:

Configure dynamic route of logical port WAN1 to allow sending RIP broadcast packet on this port,

and the renew interval is 100 seconds.

cli> add iprip lport wan1 flags send time 100

Related Commands:
      modify iprip lport, delete iprip lport

 3.4.1.4 delete ip lport

Disable IP function of logical port.

delete  ip  lport  lport

Syntax Description:

lport   Name of logical port.

Usage Guidelines:

      This command is used to disable the IP function of logical port.
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For example:

Disable IP function of logical port WAN1.

cli> delete ip lport wan1

Related Commands:

     add ip lport, modify ip lport,  show ip lport

 3.4.1.5 delete ip route

Delete static IP route.

delete  ip  route  destip

Syntax Description:

destip  Destination IP address

Usage Guidelines:

      This command is used to delete specific static IP route.

Sample Display:

Delete the static IP route of 130.1.1.100

cli> delete ip route 130.1.1.100

Related Commands:

         add ip route, modify ip route,  show ip route

3.4.1.6  delete iprip lport

Disable dynamic IP route.

delete  iprip  lport  lport

Syntax Description:

lport     Name of logical port.

Usage Guidelines:

This command is used to disable dynamic route of specific logical port, this command only applies

to the logical port which enable IP function.

Sample Display:

Disable dynamic IP route of logical port WAN1.

cli> delete iprip lport wan1

Related Commands:

          add iprip lport, modify iprip lport
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 3.4.1.7 modify ip lport

Modify the IP address of logical port.

modify  ip  lport  lport [ destip  destip  |  maskip  maskip  |  mtu  mtu  |  metric
metric ]

Syntax Description:

      Same parameter usage as command: “  add ip lport “ .

Usage Guidelines:

This command is used to modify the IP address parameter of specific logical port. If this IP is

disabled before, users may enable it again via this command. If do not specify some parameters,

enabling logical port will recover the prior settings.

Sample Display:

Modify logical port WAN1 IP = 130.1.2.100, subnet mask = 255.255.255.0, and the mtu=512.

cli> modify ip lport wan1 destip 130.1.2.100  maskip 255.255.255.0 mtu 512

Related Commands:

          add ip lport, delete ip lport, show ip lport

 3.4.1.8 modify ip route

Modify static IP route configuration.

modify  ip  route  destip [ gwip  gwip  |  maskip  maskip  |  metric metric ]

Syntax Description:

Same parameter usage as command: “  add ip route”.

Usage Guidelines:

      This command is used to modify specific static routing table.

Sample Display:
Modify the static IP route of 130.1.2.100, gateway=130.1.12.2, subnet mask = 255.255.255.0,
and the metric = 15.
cli> modify ip route 130.1.2.100 gwip 130.1.12.2 maskip 255.255.255.0 metric 15

Related Commands:

          add ip route, delete ip route, show ip route

 3.4.1.9 modify iprip lport

Modify dynamic route

modify  iprip  lport  lport [ flags  flags  |  ripmetric  ripmetric  |  time time ]
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Syntax Description:

Same as commands: “ add iprip lport”.

Usage Guidelines:

If Logical Port has activated the dynamic routing, users can use this command to modify the

activated dynamic routing table, this command can not be used to activate dynamic routing of

logical port.

Sample Display:
Modify dynamic routing of logical port WAN1, allow to receive RIP broadcast packets at this port,
and the RIP broadcast renew interval = 200 seconds.
cli> modify iprip lport wan1 flags listen time 200

Related Commands:

          add iprip lport, delete iprip lport

3.4.1.10  show arp table

Show ARP address table.

show  arp  table

Usage Guidelines:

     This command is used to display MAC address of ARP table.

Sample Display :

cli> show arp table
010.000.000.014  00:00:21:e2:f6:01

010.000.000.212  00:00:b4:50:45:04

3.4.1.11  show icmp statistics

Show ICMP statistic information.

show  icmp  statistics

Usage Guidelines:

This command is used to show the following information :
© icmpInMsgs Total number of ICMP messages which the Router received. Note

that this counter includes all those counted by icmpInErrors.

© icmpInDestUnreac Number of ICMP Destination Unreachable messages received.

© icmpInParmProbs Number of ICMP Parameter Problem messages received.

© icmpInRedirects Number of ICMP Redirect messages received.

© icmpInEchoReps Number of ICMP Echo Reply messages received.

© icmpInTimestampR Number of ICMP Timestamp Reply messages received.

© icmpInAddMaskre Number of ICMP Address Mask Reply messages received

© icmpOutErrors Number of ICMP messages which the router can not sent due to
ICMP-specific errors (for example, bad ICMP checksums, bad
length).

© icmpOutTimeExcds Number of ICMP Time Exceeded messages sent.

© icmpOutSrcQuench Number of ICMP Source Quench messages sent.
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© icmpOutEchos Number of ICMP Echo (request) messages sent.

© icmpOutTimestamp Number of ICMP Timestamp (request) messages sent.

© icmpOutAddrMasks Number of ICMP Address Mask Request messages sent.

© icmpInErrors Number of ICMP messages which the router received but
determined as having ICMP-specific errors (for example, bad ICMP
checksums, bad length).

© icmpInTimeExcds Number of ICMP Time Exceeded messages received.

© icmpInSrcQuenchs Number of ICMP Source Quench messages received.

© icmpInEchos Number of ICMP Echo (request) messages received.

© icmpInTimeStamps Number of ICMP Timestamp (request) messages received.

© icmpInAddrMasks Number of ICMP Address Mask Request messages received.

© icmpOutMsgs Total number of ICMP messages which the router sent.

© icmpOutDestUnreal Number of ICMP Destination Unreachable messages sent.

© icmpOutParmProbs Number of ICMP Parameter Problem messages sent.

© icmpOutRedirects Number of ICMP Redirect messages sent.

© icmpOutEchoReps Number of ICMP Echo Reply messages sent.

© icmpOutTimestampR Number of ICMP Timestamp Reply messages sent.

© icmpOutAddrMaskR Number of ICMP Address Mask Reply messages sent.

Sample Display:

cli> show icmp statistics
icmpInMsgs 141 icmpInErrors 0

icmpInDestUnreac 0 icmpInTimeExcds 0

icmpInParmProbs 0 icmpInSrcQuenchs 0

icmpInRedirects 127 icmpInEchos 7

icmpInEchoReps 7 icmpInTimestamps 0

icmpInTimestampR 0 icmpInAddrMasks 0

icmpInAddrMaskRe 0 icmpOutMsgs 0

icmpOutErrors 0 icmpOutDestUnrea 0

icmpOutTimeExcds 0 icmpOutParmProbs 0

icmpOutSrcQuench 0 icmpOutRedirects 0

icmpOutEchos 22 icmpOutEchoReps 7

icmpOutTimestamp 0 icmpOutTimestamp 0

icmpOutAddrMasks 0 icmpOutAddrMaskR 0

3.4.1.12 show ip lport

Show IP information of logical port

show  ip  lport  lport

Syntax Description:

lport     Name of Logical Port.

Usage Guidelines:

This command is used to display the following messages:
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© IP Address IP Address of the logical port

© Subnet Mask Subnet Mask

© MTU Maximum Transmitted Unit

© Metric Metric

© Protocol Routing Protocol

© Flags RIP protocol flags

© RIP Def. Metric RIP default metric

© RIP Bcast Time RIP broadcast interval

This command can not display the IP information of disabled Logical Port.

Sample Display:

Display IP information of logical port WAN1

cli> show ip lport wan1
IP Address 130.1.2.100 Protocol RIP

Subnet Mask 255.255.255.0 Flags SEND, LISTEN

Bcast Address 130.1.2.255 RIP Def. Metric 1

MTU 46 RIP Bcast Time 30

Metric 1

If the IP function is disabled, the following message will be shown.

cli> show ip lport wan1
IP not enabled on lport

Related Commands:

     add ip lport, modify ip lport, delete ip lport

3.4.1.13 show ip route

Show configuration of static IP route

show  ip  route [ destip  destip ]

Syntax Description:

destip    Destination IP address.

Default:

If do not specify parameter, this command is used to display all configuration of static IP route

Usage Guidelines:

This command is used to display the following messages:
© Destination IP Destination IP address : used to indicate destination IP address or

destination IP network

© IP Route Mask Subnet mask: Used with IP address to indicate destination network. Users
can combine IP address and subnet mask to generate destination network
address.

© Next Hop Next Hop IP address: IP address of next hop that IP packet will pass
through.  Same as gateway IP address of “add ip route” command.

© Metric Metric
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Sample Display:

cli> show ip route 130.1.2.100
Destination IP 130.1.2.100 IP Route Mask 255.255.255.0

Next Hop 130.1.12.2 Metric 1

Related Commands:
     add ip route, modify ip route, delete ip route

3.4.1.14 show ip statistics

Show IP statistic Information

show  ip  statistics

Usage Guidelines:
This command is used to show the following information:

© ipForwarding Indication of whether this router is acting as an IP gateway in respect
to the forwarding of datagrams received by, but not addressed to,
this router. IP gateways forward datagrams. IP hosts do not (except
those source-routed via the host).

© ipInRceives Total number of input datagrams received including those received
in error.

© ipInAddErrors Number of input datagrams discarded because the IP address in
their IP header’ s destination field was not a valid address to be
received at this device.

© ipInUnknownProtos Number of locally-addressed datagrams received successfully but
discarded because of an unknown or unsupported protocol.

© ipInDelivers Total number of input datagrams successfully delivered to IP user-
protocols (including ICMP).

© ipOutDiscards Number of output IP datagrams for which no problem was
encountered to prevent their transmission to their destination, but
which were discarded (for example, for lack of buffer space).

© ipReasmTimeout Maximum number of seconds that received fragments are held while
they are awaiting reassemble at this device.

© ipReasmOks Number of IP datagrams successfully reassembled.

© ipFragOKs Number of IP datagrams that have been successfully fragmented.

© ipFragCreates Number of IP datagram fragments that have been generated as a
result of fragmentation.

© ipDefault TTL The default value inserted into the Time-To-Live field of the IP
header of datagrams originated at ERT-2501, whenever a TTL value
is not supplied by the transport layer protocol.

© ipInHdrErrors Number of input datagrams discarded due to errors in their IP
headers.

© ipForwDatagrams Number of input datagrams for which this device was not their final
IP destination, as a result of which an attempt was made to find a
route to forward them to that final destination.
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© ipInDisCards Number of input IP datagrams for which no problems were
encountered to prevent their continued processing, but which were
discarded (for example, for lack of buffer space).

© ipOutRequests Total number of IP datagrams that local IP user-protocols (including
ICMP) supplied to IP in requests for transmission.

© ipOutNoRoute Number of IP datagrams discarded because no route could be found
to transmit them to their destination.

© ipReasmReqds Number of IP fragments received that needed to be reassembled at
this router.

© ipReasmFails Number of failures detected by the IP reassemble algorithm (for
whatever reason: timed out, errors, and so on)

© ipFragFails Number of IP datagrams that have been discarded because they
needed to be fragmented but could not be, for example, because
their Don’ t Fragment flag was set.

© ipRoutingDiscard Number of routing entries that were chosen to be discarded even
though they are valid.

Sample Display:
cli> show ip statistics
ipForwarding 1 ipDefaultTTL 254
ipInReceives 180 ipInHdrErrors 0
ipInAddrErrors 0 ipForwDatagrams 0
ipInUnknownProto 0 ipInDiscards 0
ipInDelivers 180 ipOutRequests 87
ipOutDiscards 0 ipOutNoRoutes 0
ipReasmTimeout 0 ipReasmReqds 0
ipReasmOKs 0 ipReasmFails 0
ipFragOKs 0 ipFragFails 0
ipFragCreates 0 ipRoutingDiscard 0

3.4.1.15 show tcp statistics

Display TCP statistic information

show  tcp  statistics

Usage Guidelines:
This command is used to show the following information : ¡ G

© tcpRtoAlgorithm The algorithm used to determine the timeout value used for
retransmitting unacknowledged octets. ¡ G1=other, 2=constant, 3=MIL-
STD-1778, 4=Van Jacobson algorithm

© tcpRtoMax The maximum value permitted by a TCP implementation for the
retransmission timeout.

© tcpActiveOpens Number of times TCP connections have made a direct transition to the
SYN-SENT state from the CLOSED state.

© tcpAttemptFails Number of times TCP connections have made a direct transition to the
CLOSED state from either the SYN-SENT state or the SYN-RCVD
state, plus the number of times TCP connections have made a direct
transition to the LISTEN state from the SYN-RCVD state.

© tcpCurrEstab Number of current TCP connections for which the current state is either
ESTABLISHED or CLOSE- WAIT.



- 83 -

© tcpOutSegs Total number of TCP segments sent, including those on current
connections but excluding those containing only retransmitted octets.

© tcpInErrs Total number of segments received in error (for example, bad TCP
checksums).

© tcpRtoMin The minimum value permitted by a TCP implementation for the
retransmission timeout.

© tcpMaxCom The limit on the total number of TCP connections the router can
support.

© tcpPassiveOpens Number of times TCP connections have made a direct transition to the
SYN-RCVD state from the LISTEN state.

© tcpEstabResets Number of times TCP connections have made a direct transition to the
CLOSED state from either the ESTABLISHED state or the CLOSE-
WAIT state.

© tcpInSegs Total number of segments received, including those received in error.
This count includes segments received on currently established
connections.

© tcpRetransSegs Total number of segments retransmitted - that is, the number of TCP
segments transmitted containing one or more previously transmitted
octets.

© tcpOutRsts Number of TCP segments sent containing the RST flag.

Sample Display:

cli> show tcp statistics
tcpRtoAlgorithm 4 tcpRtoMin 0

tcpRtoMax 0 tcpMaxConn 10

tcpActiveOpens 0 tcpPassiveOpens 2

tcpAttemptFails 0 tcpEstabResets 0

tcpCurrEstab 2 tcpInSegs 58

tcpOutSegs 16 tcpRetransSegs 46

tcpInErrs 0 tcpOutRsts 0

3.4.1.16  show udp statistics

Show UDP statistic information.

show  udp  statistics

Usage Guidelines:

This command is used to show the following information:

© InDatagrams Total number of UDP datagrams this router received.

© InErrors Number of received UDP datagrams that could not be delivered for reasons

other than the lack of an application at the destination port.

© Noports Total number of received UDP datagrams for which there was no application

at the destination port.

© OutDatagrams Total number of UDP datagrams sent from this router.
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Sample Display:

cli> show udp statistics

udpInDatagrams 47 udpNoPorts 120

udpInErrors 0 udpOutDatagrams 73

3.4.2  IPX Commands :

IPX commands include the following:

add ipx lport

add ipx route

add ipx server

add ipxrip lport

add ipxsap lport

delete ipx lport

delete ipx route

delete ipx server

delete ipxrip lport

delete ipxsap lport

modify ipx lport

modify ipx route

modify ipx server

modify ipxrip lport

modify ipxsap lport

show ipx lport

show ipx route

show ipx server

show ipx statistics

3.4.2.1  add ipx lport

Add IPX address of logical Port

add  ipx  lport  lport  ipxnet

Syntax Description:

lport     Name of Logical Port.

 ipxnet    IPX network number in hexadecimal format, 8 digits maximum.

Usage Guidelines:

IPX address is composed of network number and a node ID. Network number identifies a

physical network.  It is 4 bytes long (32bits) and must be unique in an IPX inter-network.  It is

expressed with 8 hexadecimal digits in configuration command. You do not need to input all 8

digit; the prior 0 can be omitted.

Sample Display:

Configure logical port WAN1’ s IPX network number as 5

cli> add ipx lport wan1 5
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Related Commands:

modify ipx lport, delete ipx lport, show ipx lport

3.4.2.2  add ipx route

Add static IPX route

add  ipx  route  destipx  ipxgnet  ipxgmac  ticks  hops

Syntax Description:

destipx Destination IPX network number

ipxgnet IPX gateway network number in hexadecimal format, 8 digits maximum.

ipxgmac IPX gateway MAC address

ticks Ticks, (1 second =18.3tick) range : 0–65535

hops Hops, range : 0 - 16

Usage Guidelines:

This command is used to add a IPX route in IPX static routing table.

Sample Display:

Add static IPX route, destination network number=77, gateway network number = 55, gateway

MAC address = 00:02:09:01:02:04, ticks = 1, and hop = 2.

cli> add  ipx  route  77  55  00:02:09:01:02:04  1  2

Related Commands:

modify ipx route, delete ipx route, show ipx route

3.4.2.3  add ipx server

Add static IPX service

add  ipx  server  srvnarne  ipxnet  servaddr  servtype  socket  hops

Syntax Description:
srvname Name of IPX service
ipxnet IPX network number in hexadecimal format, 8 digits Maximum.
servaddr IPX server address, used with ipxnet to represent the address of the IPX server that

providing IPX service.
servtgpe Types of IPX services in hexadecimal format
socket Socket of IPX service.
hops the numbers of hops to reach IPX server, range : 0 - 15

Usage Guidelines:
The service type of IPX server is expressed in hexadecimal format:0x0000=unknown, 0x0003 =
Print Queue,  0x0004 = File Server, 0x0005 = Job Server, 0x0009 = Archie Server, 0x0024 =
Remote Bridge Server, 0x0047 = Advertisement Print Server.
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Sample Display:

Add static IPX service, servername = srv1, network number = 101, node = 00:10:01:02:01:02,

Service Type = File Server, socket number = 4, hop = 10

cli> add ipx  server  srv1  101  00:10:01:02:01:02  4  4  10

Related Commands:

modify ipx server, delete ipx server, show ipx server

3.4.2.4  add ipxrip lport

Configure dynamic IPX route

add  ipxrip  lport   lport  [ flags  flags ]

Syntax Description:

lport     Name of Logical Port.
flags    Flags is used to indicate whether allow sending , receiving RIP broadcasting packets or

not.  The available parameters are: send,listen = allow sending and receiving, send =
allow sending only, listen = allow receiving only, none = disable both sending and
receiving.

Default:

When ERT-2501 is set to default, flags = SEDN, LISTEN

Usage Guidelines:
Dynamic IPX route and static IPX route can be adopted at the same time, but it is not
recommended. If dynamic IPX route is not adopted, users have to create at least one route in IPX
static route. It can have maximum 128 dynamic route entries in dynamic routing table, and
maximum 8 static route entries in IPX static route table.

Sample Display:

Configure dynamic IPX route of Logical Port WAN1, and allow it to send RIP broadcast packets.

cli> add ipxrip lport wan1 flags send

Related Commands:

     modify ipxrip lport, delete ipxrip lport

3.4.2.5  add ipxsap lport

Configure IPX SAP(service advertising protocol).

add  ipxsap  lport  lport  [ sapflags  sapflags ]

Syntax Description:

lport      Name of Logical Port.

sapflags   Sapflags is used to indicate whether allow sending , receiving SAP broadcasting

packets or not.  The available parameters are: send,listen = allow sending and

receiving, send = allow sending only, listen = allow receiving only, none = disable

both sending and receiving.

Default:
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     Default settings of sapflags are SEND,LISTEN.

Usage Guidelines:

This command is used to configure IPX SAP protocol.

Sample Display:

Configure IPX SAP protocol of logical port WAN1 to allow the router to send SAP broadcast.

cli> add ipxsap lport wan1 sapflags send

Related Commands:

     modify ipxsap lport, delete ipxsap lport

3.4.2.6  delete ipx lport

Delete IPX function of Logical Port.

delete  ipx  lport  lport

Syntax Description:

lport   Name of Logical Port.

Usage Guidelines:

This command is used to disable IPX function of specific Logical Port.

Sample Display:

Disable IPX function of logical port WAN1.

cli> delete ipx lport wan1

Related Commands:

add ipx lport, modify ipx lport, show ipx lport

3.4.2.7  delete ipx route

Delete static IPX route.

delete  ipx  route  destipx

Syntax Description:

destipx     Destination IPX network number

Usage Guidelines:

This command is used to delete specified IPX static route.

Sample Display:

Deletes a static IPX route with network number 107.

cli> delete ipx route 107

Related Commands:

add ipx route, modify ipx route, show ipx route
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3.4.2.8  delete ipx server

Delete a static IPX service.

delete  ipx  server  srvname

Syntax Description:

srvname     name of IPX service

Usage Guidelines:

This command is used to delete specified static IPX service.

 Sample Display:

Delete static IPX service svr1

cli> delete ipx server srv1

Related Commands:

add ipx server, modify ipx server,  show ipx server

3.4.2.9  delete ipxrip lport

Disable dynamic IPX route

delete  ipxrip  lport  lport

Syntax Description:

lport   Name of Logical Port

Hint  :

This command is used to disable dynamic IPX route of specified logical port

Sample Display:

Delete dynamic route of IPX on logical port WAN1.

cli> delete ipxrip lport wan1

Related Commands:

add ipxrip lport, modify ipxrip lport

3.4.2.10  delete ipxsap lport

Delete SAP protocol of IPX

delete  ipxsap  lport  lport

Syntax Description:

lport   Name of Logical Port.
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Usage Guidelines:

This command is used to delete the IPX SAP protocol specified logical port.

Sample Display:

Delete SAP protocol on logical port WAN1.

cli> delete ipxsap lport wan1

Related Commands:

     add ipxsap lport,  modify ipxsap lport

3.4.2.11  modify ipx lport

Modify IPX address of logical port

modify  ipx  lport  lport  [ ipxnet  ipxnet ]

Syntax Description:

      Same parameter usage as the command: “add ipx lport” .

Usage Guidelines:

This command is used to modify the IPX network number of logical port. If it is disabled, users

can re-enable IPX function using this command. If network number is not specified in this

command, it will recover the prior network number.

Sample Display:

Modify IPX network number of logical port WAN1 to be 15.

cli> modify ipx lport wan1 ipxnet 15

Related Commands:

      add ipx lport, delete ipx lport, show ipx lport

3.4.2.12  modify ipx route

Modify static IPX route.

modify  ipx  route  destipx [ ipxgnet  ipxgnet  |  ipxgmac  ipxgmac  | ticks  ticks  |

hops  hops ]

Syntax Description:

      Same parameter usage as command: “add ipx route”

Usage Guidelines:

This command can be used to modify statistic IPX route.
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Sample Display:

Modify network number 67 of static IPX route to gateway network number = 55, and hop = 15.

cli> modify ipx route 67 ipxnet 55 hops 15

Related Commands:

     add ipx route, delete ipx route, show ipx route

3.4.2.13  modify ipx server

Modify static IPX service.

modify  ipx  serve  srvnarne [ ipxnet  ipxnet  |  servaddr  servaddr  |  servtype
servtype  |  socket  socket  |  hops  hops ]

Syntax Description:

      Same parameter usage as command: “  add ipx server”.

Usage Guidelines:

This command is used to modify static IPX service.

Sample Display:

Modify static IPX service srv1 with network number = 101, server node = 0:10:01:02:29:30,

socket = 1, hop = 12

cli> modify ipx server srv1 ipxnet 101 servaddr 00:10:01:02:29:30 socket 1 hops 12

Related Commands:

      add ipx server, delete ipx server, show ipx server

3.4.2.14  modify ipxrip lport

Modify dynamic IPX route.

modify  ipxrip  lport  lport  [ flags  flags ]

Syntax Description:

      Same parameter usage as command: “  add ipxrip lport “ .

Usage Guidelines:

If dynamic IPX route on logical port has been enabled, users can use this command to modify IPX

dynamic route configuration of logical port. This command can not be used to enable the dynamic

IPX route of logical port.

Sample Display:

Modify dynamic IPX route of logical port WAN1, and allow it to receiving RIP broadcast packets.

cli> modify ipxrip lport wan1 flags listen

Related Commands:

      add ipxrip lport, delete ipxrip lport
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3.4.2.15  modify ipxsap lport

Modify configuration of IPX SAP protocol.

modify  ipxsap  lport  lport  [ sapflags  sapflags ]

Syntax Description:

      Same parameter usage as command: “  add ipxsap lport “ .

Usage Guidelines:

This command is used to modify configuration of IPX SAP protocol on logical port WAN1.

Sample Display:

Modify IPX SAP protocol of logical port WAN1 to allow router to receive SAP broadcast.

cli> modify ipxsap lport wan1 sapflags listen

Related Commands:

     add ipxsap lport, delete ipxsap lport

3.4.2.16  show ipx lport

Show IPX address information of logical port.

show  ipx  lport  lport

Parameters :

     lport   Name of Logical Port.

Usage Guidelines:

This command can be used to show IPX information of logical port:

© Network Number IPX Network Number

© RIP Flags RIP Flags

© SAP Flags SAP Flags

© Protocol IPX dynamic routing protocol

This command can not show information of logical port of which IPX function have been disabled.

Sample Display:

Display IPX address information of active IPX logical port WAN1.

cli> show ipx lport wan1
Network Number           15       RIP Flags    SEND, LISTEN

SAP Flags     SEND, LISTEN       Protocol                RIP

If IPX function of WAN1 is disabled, it will response the following message:

cli> show ipx lport wan1

IPX not enabled on lport

Related Commands:

add ipx lport, modify ipx lport, delete ipx lport
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3.4.2.17  show ipx route

Show static IPX route information.

show  ipx  route  [ destipx  destipx ]

Syntax Description:

     destipx   Destination IPX Network number

Default:

     If do not specify parameter, this command will show all the IPX information.

Usage Guidelines:

     This command is used to display the following information:

© Destination Net Destination IPX Network Number.

© Gateway Net IPX gateway network number

© Gateway MAC IPX gateway MAC address.

© Ticks How many ticks will it take to the destination.

© Hops How many hops will it take to the destination.

Sample Display:

Display Static IPX route information.

cli> show ipx route destipx 77
Destination Net               77         Ticks       1

Gateway Net                    55         Hops        2

Gateway MAC  00:20:0a:11:22:34

Related Commands:

add ipx route, modify ipx route, delete ipx route

11.4.2.18  show ipx server

Show static IPX server information.

show  ipx  server  srvname

Parameters:

     srvname   IPX service name

Usage Guidelines:

This command is used to show the following information:

© IPX Server IPX server name

© Network Number IPX network number

© Server Address IPX server address (node number)

© Server Type IPX Service Type

© Socket Socket number of IPX service

© Hops How many hops will it take to the destination.

Sample Display:

Show statistic information of static IPX server srv1.

cli> show ipx server srv1
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IPX Server srv1 Server Type 4

Network Number 257 Socket 4

Server Address 01:02:01:02:01:02 Hops 10

Related Commands:

add ipx server, modify ipx server, delete ipx server

3.4.2.19  show ipx statistics

Show IPX statistics information

show  ipx  statistics

Usage Guidelines:

This command is used to show the following information:
© ipxInReceives Total number of input packets including those received in error.

© ipxInAddrErrors Number of input packets discarded because the destination address
was not a valid address to be received at this router.

© ipxInUnknownProt Number of locally-addressed packets received successfully but
discarded because of an unknown or unsupported protocol.

© ipxInDelivers The number of packets delivered to a higher layer protocol.

© ipxOutDiscards Number of out IPX packets for which no problem were encountered to
prevent their transmission to their destination, but which were
discarded (for example, for lack of buffer space)

© ipxInHdrErrors Number of input packets discarded due to errors in their IPX headers.

© ipxForwDatagrams Number of input packets for which this router was not their final IP
destination, as a result of which an attempt was made to find a route
to forward them to that final destination.

© ipxInDiscards Number of input IPX packets for which no problem were encountered
to prevent their continued processing, but which were discarded (for
example, for lack of buffer space).

© ipxOutRequests Total number of IPX packets that supplied to router in requests for
transmission.

© ipxOutNoRoutes Number of IPX packets discarded because no route could be found to
transmit them to their destination.

Sample Display:

cli> show ipx statistics
ipxInReceives 2 ipxInHdrErrors 0

ipxInAddrErrors 0 ipxForwDatagrams 0

ipxInUnknownProt 0 ipxInDiscards 0

ipxInDelivers 2 ipxOutRequests 4

ipxOutDiscards 0 ipxOutNoRoutes 3

3.5 Firewall Configuration Commands

 3.5.1 Command List

Firewall configuration commands include the following:

add ip filter
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delete ip filter

modify ip filter

show ip filter

 3.5.2 add ip filter

Add an item on the IP firewall list
add  ip  filter  srcip  srcmask  destip  desmask  port  protocol  action

Syntax Description:

srcip Source IP address

srcmask Subnet mask of Source IP address

destip Destination IP address

desmask Subnet mask of Destination IP address (Drop action does not apply to desmask and

desip.)

port Port numbers of TCP and UDP.

protocol IP upper layer protocol number

action Action : drop = Discard the packets which match the IP firewall list

                   forward = Forward the packets which match the IP firewall list

Usage Guidelines:

Concerning to different application protocols, the corresponding IP upper layer protocol number

and port number are listed below:

Telnet ftp tftp nntp smtp http tcp udp icmp any

Protocol

Number
6 6 0 0 6 0 6 17 1 0

Port

Number
23 21 69

11

9
25 80 0 0 0 0

This command is used to configure how ERT-2501 handles the IP packets.  Forward legal IP

packets and discard illegal IP packets to secure the network.

Sample Display:

Prevent computers on network segment (130.1.2.0) to perform http access.

cli> add ip filter 130.1.2.0  255.255.255.0  0.0.0.0  0.0.0.0  80  0  drop

Related Commands:

modify ip filter, delete ip filter, show ip filter

 3.5.3 delete ip filter

Delete an item on IP firewall list

delete  ip  filter  srcip

Syntax Description:

srcip   Source IP saddress of filter
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Usage Guideline:

This command is used to delete an item on the IP firewall list.

Sample Display:

Delete IP firewall item (130.1.2.0)

cli> delete ip filter 130.1.2.0

Related Commands:

add ip filter, modify ip filter, show ip filter

 3.5.4 modify ip filter

Modify an item on IP firewall list

modify  ip  filter  srcip  [ srcmask  srcmask  |  destip  destip  |  desmask desmask  |

port  port  |  protocol  protocol  |  action  action ]

Syntax Description:

      Same parameter usage as the command: “add ip filter”.

Usage Guidelines:

      This command is used to modify an item on that IP firewall list.

Sample Display:

Modify the IP firewall list of the source IP (130.1.2.0) of which ftp is its upper layer protocol.

cli> modify ip filter 130.1.2.0 port 21 protocol 6

Related Commands:

add ip filter, delete ip filter, show ip filter

 3.5.5 show ip filter

Display configuration information of IP firewall list

show  ip  filter [ srcip  srcip ]

Syntax Description:

srcip Source IP address

Default:

If do not specify parameter, this command will display all the configuration information of IP

firewall list.

Usage Guidelines:

     This command is used to display the following information:
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© Source IP Source IP address

© Source Mask Subnet mask of Source IP network

© Destination IP     Destination IP address

© Destination Mask Subnet mask of Destination IP network

© Port Port numbers of TCP and UDP.

© Protocol Protocol numbers of IP upper layer protocols.

© Action Action

Sample Display:

cli> show ip filter 130.1.2.0

Source IP 130.1.2.0 Port 80

Source Mask 255.255.255.0 Protocol 0

Destination IP 0.0.0.0 Action Forward

Destination Mask 0.0.0.0

Related Commands:

add ip filter, modify ip filter, delete ip filter

3.6 Bridge Connection Configuration Commands

 3.6.1 Commands List

Bridge connection includes the following commands:

add bridge lport

add bridge parameters

delete birdge lport

modify bridge parameters

show bridge lport

show bridge parameters

show bridge statistics

3.6.2  add bridge lport

Add bridge on logical port

add  bridge  lport  lport

Syntax Description:

lport   Name of Logical Port

Usage Guidelines:

This command is used to add bridge to logical port.

Sample Display:

Add a bridge on the logical port WAN1.

cli> add bridge lport wan1
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Related Commands:

delete bridge lport, show bridge lport

 3.6.3 add bridge parameters

Add bridge configuration parameters

add  bridge  parameters  name  [ priority  priority  |  stp  stp ]

Syntax Description:

name    Bridge name

priority  Priority of bridge, range: 0 -65535

stp      Spanning Tree Protocol, enabled or disabled.

Default:

When ERT-2501 is set to default, bridge priority = 0, and the spanning tree protocol is disabled.

Usage Guidelines:

Spanning tree protocol utilizes bridge ID to select the root bridge. Bridge ID is composed of

bridge priority and MAC address of their Ethernet port. Due to the uniqueness of MAC address,

the bridge IDs will be different even they are assigned the same priority. Root bridge is chosen by

comparing the bridge ID.

Sample Display:

Configure parameters of bridge: name = vegas1, priority = 15, and enable spanning tree protocol.

cli> add bridge parameters vegas1 priority 15 stp enabled

Related Commands:

modify bridge parameters, show bridge parameters

 3.6.4 delete bridge lport

Disable bridge function of logical port

delete  bridge  lport  lport

Syntax Description:

lport   Name of the Logical Port.

Usage Guidelines:

This command is used to disable the bridge function of logical port.

Sample Display:

Disable the bridge function of logical port WAN1.

cli> delete bridge lport wan1
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Related Commands:

add bridge lport, show bridge lport

3.6.5 modify bridge parameters

Modify parameters of bridge configuration.

modify  bridge  parameters [ name  name  | priority  priority  |  stp  stp ]

Syntax Description:

Same parameter usage as command: “  add bridge parameters”.

Usage Guidelines:

This command is used to modify the parameters of bridge configuration.

Sample Display:

Modify bridge name = vegas1, priority = 10 and disable the spanning tree protocol.

cli> modify bridge parameters name br1 priority 10 stp disabled

Related Commands:

add bridge parameters, show bridge parameters

 3.6.6  show bridge lport

Show whether bridge on logical port is enabled or not.

show  bridge  lport  lport

Syntax Description:

lport   Name of Logical Port.

Usage Guidelines:

This command is used to show whether bridge enabled or not.

Sample Display:

cli> show bridge lport wan1
Bridge Enable       Yes

Related Commands:

add bridge lport, delete bridge lport

3.6.7 show bridge parameters

Show configuration of bridge

show  bridge  parameters

Usage Guidelines:
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This command is used to display the following information:

© Bridge Name Bridge name

© Hello Time Interval of Hello packets

© Aging Time Aging Time of MAC address table

© Forward Delay Forward Delay

© Priority Priority of bridge

© STP Enable STP Enable or not

© Max. Age Maximum aging time of spanning tree information

© Multicast Addr Multicast address

Sample Display:

cli> show bridge parameters

Bridge Name bridge1 Hello Time 10

Aging Time 3600 Forward Delay 10

Priority 0 STP Enable Yes

Max. Age 30 Multicast Addr 01:80:c2:00:00:00

Related Commands:

add bridge parameters, modify bridge parameters

 3.6.8 show bridge statistics

Show bridge statistics information

show  bridge  statistics

Usage Guidelines:

This command is only used for development and tuning purpose.

Sample Display:

cli> show bridge statistics


	Table of content
	Chapter 1 Introduction
	1.1 About ERT-2501
	1.2 ERT-2501 Typical Application
	1.3 Product Configuration

	Chapter 2 NetGrip User's Guide
	2.1 Enter NetGrip
	2.2 NetGrip Menu
	2.3 Router's parameters configuration

	Chapter 3 Command Line Interface
	3.1 System Commands
	3.2 Port Configuration Commands
	3.3 WAN Protocol Configuration Commands
	3.4 Frame Relay Configuration Commands
	3.5 Firewall Configuration Commands
	3.6 Bridge Connection Configuration Commands


